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1. Introduction 
EPSRgui has been created to provide a graphical user interface for the Empirical Potential Structure 

Refinement (EPSR) routines. For more information on EPSR please refer to the EPSR manual. EPSRgui 

therefore acts as a ‘front-end’ for the EPSR routines, thus reducing the need for command 

prompt/terminal commands but still producing the same result as EPSRshell. 

The structure of an EPSRgui project is very similar to that in EPSR. Simulations are set up as project 

folders, often, although not necessarily, in the EPSR/run directory. For simplicity, the simulation box 

is automatically named <project name>box.ato. If an existing simulation is imported, the simulation 

box will retain its existing filename. 

If a simulation box is particularly large or the component molecule is complex, some of the EPSR 

processes might take a little longer than usual and EPSRgui will appear non-responsive while the 

process finishes. Please be patient while this is happening - messages are given at the bottom of the 

window and also in Settings->Show messages once the process has finished. For longer EPSR 

processes (fmole and running EPSR) command prompt /terminal windows are opened so EPSRgui 

can still be used while they are running. Closing these windows before an EPSR process has finished 

will cause the process to stop immediately and is not recommended. If this does happen, any data 

might not be saved, and files may become corrupted. 

EPSRgui remembers the files associated with the project so that the project can be opened again 

later and work on the simulation resumed. EPSRgui makes a project file with extension .EPSR.pro 

where all this information is stored. 

Note that EPSRgui is compatible with EPSR version 24 onwards. 
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2. Installation and setup 

2.1. Installing EPSR 
Go to the Disord Matt Facebook page for links to download the latest distribution of EPSR (via the 

Download Gudrun and EPSR link) from Dropbox. 

 

2.1.1. Windows 

Unpack the EPSRxxdistribution.zip into a suitable location – either directly on to the C: drive or 

where programs are usually kept.  

Java needs to be installed in order to run a number of the EPSR and EPSRgui routines. Look in 

Program Files (including x86) for a folder named Java. If it is not there, go to 

https://java.com/download to download the latest Java software. 

In the EPSRXXdistribution\EPSR\startup folder, make sure the system_commands_windows.txt file is 

appropriate for your computer. Make sure the system_jmol path contains the correct path to the 

Java executable on your computer e.g.: 

system_jmol  "C:\Program Files\Java\jre1.8.0_31\bin\java.exe" -jar %EPSRbin%\Jmol.jar 

 

2.1.2. Linux 

Unpack the EPSRxxdistribution.zip into a suitable location. This should create two folders called EPSR 

and EPSRfiles in that location. To compile the binaries, first ensure the gfortran compiler is installed 

and operational. Then open a terminal window and cd to the EPSRfiles folder. Type 

make -f makefile_xxx clean  

Then type 

make -f makefile_xxx 

This should compile all the EPSR routines and put the binaries in EPSR/bin. 

If you need to compile the PGPLOT binaries (map2d, map3d, etc.) then in the EPSRfiles/src/newsrc 

folder are other makefiles that will do this, namely makefile_linux and makefile_mac. (Ignore any 

other makefiles you find in this folder.) However you will need to edit the line 'PGPLOT_LIB=' in 

these makefiles to make sure it points to the corresponding files for your system. Then follow the 

above instructions to compile the routines. 

Java needs to be installed and executable in order to run a number of the EPSR and EPSRgui 

routines. If you want to run MOPAC, then download and install MOPAC, and make sure it has the 

correct permissions to run. 

In the EPSRXXdistribution/EPSR/startup folder, make sure the definitions in the 

system_commands_Linux.txt file are appropriate for your computer. Make sure the system_mopac 

path is also appropriate. 

https://java.com/download
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2.1.3. Mac 

Follow instructions for a Linux installation. 

 

2.2. Installing EPSRgui 

2.2.1. Windows 

Download the EPSRgui installer from ftp://ftp.nd.rl.ac.uk/scratch/EPSRgui/EPSRgui Windows 

installer and run the executable (for the ftp site: username = anonymous password = your email 

address). Run EPSRgui via the Start menu; a command prompt window will open at the same time as 

EPSRgui. 

 

2.2.2. Linux 

EPSRgui requires the Qt5 libraries (Qt4 is not compatible) so ensure your OS is Qt5 compatible. Qt is 

often already installed on Linux operating systems; ensure the Qt5 packages qt5-default, qt5-qmake 

and qtdeclarative5 are installed on your system. Also ensure make and g++ are installed. Download 

the EPSRgui source code from https://github.com/samcallear/EPSRgui. Unzip the EPSRgui folder to 

an appropriate directory (usually where all other source code/programs are kept) and then open this 

folder in a terminal window and type 

qmake –qt5 

Once qmake has finished type 

make 

If there is a problem with the make file, run make clean before running make again.  

To run EPSRgui, open a terminal window and navigate to the EPSRgui folder. Then type 

./EPSRgui 

 

2.2.3. Mac 

Download the EPSRgui installer from ftp://ftp.nd.rl.ac.uk/scratch/EPSRgui/EPSRgui Mac installer (for 

the ftp site: username = anonymous password = your email address). Run the installer and then copy 

the EPSRgui app bundle to Applications. To run EPSRgui double click on the EPSRgui icon in 

Applications. This will first open a terminal window (which can sometimes be slow) and then 

EPSRgui. 

 

2.3. Setting up EPSRgui 
Before EPSRgui can be used, the directory to the EPSR binaries must be defined via the Settings 

menu, EPSRgui settings option. In the window that appears, click Browse on the EPSR bin directory 

line, navigate to the EPSR/bin directory and click Choose. The version of EPSR that is specified here 

ftp://ftp.nd.rl.ac.uk/scratch/EPSRgui/EPSRgui Windows installer
ftp://ftp.nd.rl.ac.uk/scratch/EPSRgui/EPSRgui Windows installer
https://github.com/samcallear/EPSRgui
https://github.com/samcallear/EPSRgui
ftp://ftp.nd.rl.ac.uk/scratch/EPSRgui/EPSRgui Mac installer
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will be used for all projects, including simulations that have been imported and were previously 

created/run using a different version of EPSR. 

To set a default directory for projects to be saved to, e.g. the EPSR run directory, click Browse on the 

Default project directory line, navigate to the EPSR/run directory and click Choose. Click OK to save 

the changes. 

These defaults can be edited at any time, but an EPSR/bin directory must be specified in order to use 

EPSRgui. If the EPSR binaries folder is changed, then that setting is saved and the newly specified 

EPSR binaries folder will be used for all projects from that point forward (or until the setting is 

changed again). 
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3. Overview 

 

 

The EPSRgui main window is split into four sections. The Menu bar includes options to start or 

import a new project, run or stop a simulation, plotting, settings and access to the EPSR and EPSRgui 

manuals. The Tabs contain all the facilities to build and edit a simulation. The Quick plots enable 

rapid viewing of the simulation as it progresses. For more detailed plotting with additional options, 

use the Plot menu. The Messages area shows what is being done/has just been completed by 

EPSRgui and whether EPSR is running or not (for the current project). A more verbose output from 

the EPSR routines is given in the messages window accessed via the Settings menu. 

 

 

 

  

Menu bar 

Tabs Quick plots 

Messages 
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4. Menu bar 

4.1. File 

4.1.1. Create new project 

 

Creating a new project creates a folder that has the same name as the project. The project folder can 

be created in any directory but it is recommended that no “.” are used in the directory name. A 

project file is also created in the project folder that has the same name as the project and has the 

extension .EPSR.pro. Key information about the project is automatically saved to this file so as the 

project can be re-opened later. 

 

4.1.2. Open 

A project can be re-opened where it was last left by opening the .EPSR.pro file. 

 

4.1.3. Save as 

 

Save as enables the entire project to be copied to a new project name. The new project is then 

opened by EPSRgui. 

 

4.1.4. Import 
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An existing EPSR simulation can be imported by specifying the folder containing the existing 

simulation and some key files: the simulation box .ato file, the EPSR input (.inp) file and the EPSR 

script file.  

By default the simulation will be imported as an EPSRgui project in the original folder and keeping its 

original project name. To create an EPSRgui project of the simulation in a different directory, browse 

to a different directory in the Import to line (the EPSRgui project folder containing the simulation will 

be placed in this directory). This will leave the original simulation unchanged, but will make a copy of 

the simulation in a new folder and create an EPSRgui project for it. To change the name of the 

simulation, change the Project name line. This will create an EPSRgui project folder with the new 

name and containing a copy of all the files from the original simulation. 

If an EPSR routine is then called via EPSRgui, the routine being used will be that determined by the 

EPSR\bin folder defined in EPSRgui Settings which will not necessarily be the same as that used to 

run the simulation before it was imported.  

 

4.1.5. Exit 

If an EPSR simulation is running, it should be stopped (see Section 4.3.3) and allowed to complete 

the final iteration before clicking Exit. If Exit is clicked while EPSR is running a warning message will 

appear advising this, as premature exit can cause problems on re-opening EPSRgui. 

 

4.2. Edit 

4.2.1. Delete simulation box 

This will delete the simulation box .ato file, any weights files made and the .EPSR.inp and .pcof files if 

they have been created. This cannot be undone. 

 

4.2.2. Delete EPSR input file 

This will delete the .EPSR.inp and EPSR.pcof files only. This cannot be undone. 

 

4.3. Run… 

4.3.1. Run EPSR once 

The values in the EPSR Input File tab are saved to the EPSR .inp and .pcof files and then EPSR is run 

for a single iteration only. Note that most things are not editable while EPSR is running. Once the 

simulation has been run once, the plotting windows become enabled. Any analysis routines listed in 

the Running in EPSR section of the Analysis tab will also be run once. 
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4.3.2. Run EPSR 

The values in the EPSR Input File tab are saved to the EPSR .inp and .pcof files and then EPSR will run 

iteratively until Stop EPSR is clicked. Note that most things are not editable while EPSR is running. 

Once the simulation has been run once, the plotting windows become enabled. Any analysis 

routines listed in the Running in EPSR section of the Analysis tab will also be run after each iteration 

of EPSR (unless defined differently in the analysis routine setup). 

 

4.3.3. Stop EPSR 

On clicking Stop EPSR, EPSR will stop once it has completed the current iteration. The ESPR .inp and 

.pcof files will be automatically reloaded into EPSRgui at the end of the last iteration. 

 

4.4. Plot 

4.4.1. Plot simulation box 

 

The Plot Simulation Box dialog window gives options as to which atoms and how much of the box to 

plot. The default setting on clicking Plot box is to plot the whole box with all of the atoms in it. This 

shows a snapshot of the current simulation and does not update as the simulation is running. It also 

creates a .xyz file which can then be opened in a different program. 

To plot a subset of the box, click on the atoms to be excluded from the plot (use Ctrl to select 

multiple atoms) and click Plot box. 

To plot only a part of the box, input the number of the component to be plotted in the middle of the 

box (this is according to list of components in the simulation box, e.g. if the list contains 40 Si atoms 

and then 80 O atoms, then the Si components will be 1 – 40 and the O components will be 41 – 120) 
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and then edit the distances along x, y and z to specify how much of the box is to be plotted. To 

rotate the box, edit the phi, theta, chi coordinates. Then click Plot box. 

 

4.4.2. Plot data 

 

The EPSRgui plotting window offers more capabilities than the Quick Plots and enables plotting of 

data from the simulation. In the Select plot type box, the first column enables plotting of the 

following parameters: 

Plot type Description 

F(Q) Experimental data (dots), simulated data (line) and difference (grey line). 

G(r) Fourier transform of experimental data (dots), simulated data (line) and 

difference (grey line). 

Energy Energy of the simulation in kJ / mol 

R-factor Calculated R-factor for the simulation 

g(r) inter Intermolecular/atomic pair correlation functions; requires atom pairs to be 

specified. Coordination numbers are included by default but can be 

removed from the plot in the Options menu. The g(r) calculated from the 

experimental data (depending on the isotopic contrasts, according to the 

method outlined in the EPSR manual) can be included in the plot using the 

Options menu. 
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g(r) intra Intramolecular pair correlation functions; requires atom pairs to be 

specified. 

s(q) inter Intermolecular/atomic partial structure factors; requires atom pairs to be 

specified. 

s(q) intra Intramolecular partial structure factors; requires atom pairs to be specified. 

ereq vs fit The energy (amplitude) of the empirical potential plotted against the quality 

of the fit. This is only available for simulations run using EPSR24 onwards. 

empirical potentials Requires atom pairs to be specified. 

 

To plot anything that requires a pair of atoms to be specified, first select the first atom of the pair 

from the first column of atoms and then select the second atom from the second column in the 

Select atom pair box. Then click the >> button to add the pair to the list of pairs to be plotted. 

Repeat this until all the pairs you want to plot are listed, then click Plot. To remove a pair from the 

list, click on it and then click <<. 

In the second column of the Select plot type box, the output files for any analysis calculations that 

have been run are shown. For analysis routines with multiple calculations, the first calculation is 

plotted by default. To change this, see Plot type specific options. 

Once the plot type has been selected (and any atom pairs added) click Plot. These plots do not 

automatically update, so click Plot again to update them. 

To zoom and focus the plotting window: 

Action Function 

Mouse roller button Zoom in and out by equal amounts in the x and y axis. 

Left click and drag Drag the plot to a different area for viewing. 

Shift + mouse roller button Zoom in or out along the x axis only. 

Ctrl +mouse roller button Zoom in or out along the y axis only 

 

For additional plotting options, click the Options button at the bottom right hand corner of the 

window. To hide the options menu click the same button again. The menu options are: 

Option Description 

Axes To set the axes limits, enter a number into the appropriate axis box – if the 

box is blank a default value will be used. 

To change between linear and log axes, click the log or linear buttons. 
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Stack plots For any multi dataset plots, the offset between the datasets in the stack 

plot can be automatically chosen (Auto offset) or chosen manually 

selecting Manual offset and entering an offset. This offset will be used 

between each of the datasets. 

To shift all the datasets along the y axis (e.g. for use when plotting on a log 

scale), change the Zero offset along y. 

Plot type specific 

options 

To show/hide the residual or difference curves for the F(Q) and G(r) plots, 

tick/untick Show residual. The offset of the residual with respect to the 

calculated and experimental datasets can also be specified. 

For the intermolecular partial radial distribution functions (g(r) inter) the 

coordination number can be displayed/removed from the plot by 

ticking/unticking Include CNs. 

For analysis routines with multiple calculations, the first calculation is 

plotted by default. To change this, first select the output file in the second 

column of the Plot type box, then select the appropriate calculation in the 

Calculation to be plotted list and click Plot. 

Save plot as image The plot can be saved as a .jpg/.png/.bmp by clicking Save. 

 

4.4.3. Plot using EPSRshell 

This opens EPSRshell in a command prompt window which allows plotting using gnuplot. When 

finished, close the window by typing q. See the EPSR manual for more information. 

 

4.4.4. Density plots 

Once a density plot calculation has been setup and run (at least one iteration) with EPSR (see Section 

9) the results can be plotted from this menu option. Select the plotting routine type from the list and 

then select the analysis routine name from the file browser in order to plot the density function.  

 

4.5. Settings 

4.5.1. EPSRgui settings 

The Settings menu contains the EPSRgui settings which determine which version of EPSR is running. 

This must be set before EPSRgui can be used. Additional options such as a default directory for 

EPSRgui projects, or an alternative visualiser (that is compatible with EPSR .mol and .ato files) can 

also be set. 

 

4.5.2. EPSR messages 

View all the messages produced by EPSR while running an EPSR routine. 
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4.5.3. Project notes 

Notes about the project can be made and saved along with the project for future reference. 

 

4.6. Help 

4.6.1. EPSR manual 

The EPSR manual opened is that associated with the binaries set in EPSRgui Settings. 

 

4.6.2. EPSRgui manual 
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5. Components tab 

 

The Components tab is split into two sections – the first to build/load the atomic or molecular 

components that will be added to the simulation box, and the second to edit these components. 

Components are defined by an EPSR .mol file (this is a different format to an MDL .mol file which is 

not compatible with EPSR or EPSRgui) and an .ato file. EPSRgui offers a number of ways to build the 

components (atoms, molecules and lattices) to go into the simulation box, outlined below. 

 

5.1. Create new 

 

Create a molecule or single atom in Jmol and run MOPAC if desired (for Linux and Mac make sure 

MOPAC is installed and executable). Once the component has been created in Jmol , save as a .jmol 
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file. EPSRgui will then create an EPSR .mol and .ato file for the component and it will be added to the 

list of components. For more details on using Jmol, refer to Tutorial 2 in Section 11. Do not use a ‘.’ 

within the filename of the new component.  

 

5.2. Load existing 
In the file browser that opens, navigate to the component .mol file and load it into the project. A 

copy of this component will be created in the project directory which is then used with the project. 

Any missing component .ato files will also be created during this process. 

 

5.3. Create single atom 

 

Complete the fields in the dialog box to create a single atom. Note that EPSRgui does not check 

feasibility of the values entered so double check them after input. 
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5.4. Create atomic lattice 

 

An atomic lattice is generated from an existing EPSR .unit file and/or by filling out the fields in the 

dialog box. The lattice can be used as the simulation box or as a component. If used as a component, 

note that the component does not have a .mol file, only a .ato file in this instance only. 

 

5.5. Make component externally 
This can be used to generate any component within the capabilities of the software specified by the 

Alternative visualiser in EPSRgui Settings. Remember to save the component as an EPSR .mol and 

also an .ato file of the same name as both of these are used in EPSRgui. Once the component has 

been saved, use Load existing to add the component to the project. 

 

5.6. Run dockato 
This is currently not implemented. 

 

5.7. View selected 
Once a component has been created/loaded into the project it can be viewed by clicking View 

selected. Jmol will be used to view the component unless an Alternative visualiser has been set in 

EPSRgui Settings. 
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5.8. Remove selected 
To remove a component from the project click Remove selected. 

 

5.9. Edit selected component 
Once a component has been loaded into EPSRgui, its Lennard-Jones potential and charge can be 

edited together with various molecular constraints such as bond distances, angles and rotational 

groups. It is imperative to click Update after making any changes in order for the changes to be 

saved to the component. If another component is selected from the list before clicking Update, any 

changes made to the previous component will be lost. If the simulation box has already been 

created, any changes made to the components (via the Components tab) must be applied to the 

simulation box by clicking Run fmole in the Simulation Box tab (see Section 6). The number of 

iterations is dependent on the system and the changes made. For more details on fmole refer to the 

EPSR manual. 

For newly created components, the Label column in the Atom Types table shows the unique number 

for each atom in the component which cannot be changed. To check which atom is which within the 

molecule, click View Selected and then show labels. For molecular components, these numbers are 

used to define the atoms involved in bond distance, bond angle and dihedral angle restraints and 

rotational axes. They are also used in a number of the Analysis routines (see Section 9). In the Atom 

Types table, each of the atom Labels is assigned a Type which is the name given to an atom or group 

of atoms and is used to associate a Lennard-Jones potential with a particular atom or group of 

atoms. Only atoms in very similar environments should be grouped together. The name can be 

changed to anything containing letters or numbers between one to three characters long where the 

first character is a letter and is a capital. When editing the atom Type, it is very important to also 

change the atom Type in the Lennard-Jones potentials tab (see below). For systems with multiple 

components, the same atom Type cannot be used in more than one component. 

For old components the Atom Types table may be blank. If this is the case, the Type for each atom in 

this component and the number of Lennard-Jones parameters cannot be changed via EPSRgui. The 

bond distance and bond angle restraints will be defined using the atom Type as the atom name. The 

dihedral angles and rotational axes will be defined using the numerical label for each atom which 

can be seen by selecting the component in the list and clicking View Selected and then selecting 

show labels. 

In the Define Component box, there are a number of tabs, all of which can have rows 

inserted/removed using the Insert Row Above/Insert Row Below/Delete Row/Delete All buttons: 

Tab Name Description 

Lennard-Jones 

potentials 

Each different atom Type defined in the Atom Types table (not for old .mol 

files, see above) must have an equivalent atom Type in the Lennard-Jones 

potentials table – this can be appropriate for a single atom or group of 

atoms in a very similar environment. If the atom Type is renamed in the 

Atom Types table, it must also be renamed in the atom Type column of the 

Lennard-Jones potentials table. Additional/superfluous atom Types and 
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their Lennard-Jones parameters can be added/ removed as needed. The 

values for the Lennard-Jones potential, atomic weight, charge and element 

can all be edited. An atomic weight of 2 is generally used for H and D. Click 

Update to save any changes. The overall Charge of the component is given 

above the Update button – it is recalculated when Update is clicked. 

Bond distances Distance between a specified pair of atoms (using the atom Label if 

present, otherwise using the atom Type) in Å. 

Bond angles Angle between a specified triplet of atoms (using the atom Label if present, 

otherwise using the atom Type) in degrees. 

Dihedral angles Angle between two planes defined by two pairs of atoms (always using the 

numerical atom Label). 

Rotational axes Axis about which the component can rotate, defined by a pair of atoms 

(always using the numerical atom Label). 

Additional details if  opening an existing component with an old-style .mol file where all the 

atoms are positioned on 0,0,0 (check this by clicking View selected - if you 

see only one atom when you should see more then it is an old-style .mol 

file) you will need to click Run fmole on component. This implements all 

the bond and angle etc restraints that are in the .mol file. You can then 

check the molecule looks as it should by clicking View Selected again. 

For components that will be the container when using Addato, the size of 

the container can be seen – to change the size and/or shape of this box, 

click Run changeato for selected file – this will run the EPSR routine 

changeato within a command prompt/terminal window. After changes 

have been made, type e to exit and save. If the component needs to be 

tethered, tick Tethered? and input the number for the tethering atom (use 

0 for the centre of mass of the component), the tethering tolerance (a 

small number is more tightly tethered) and the tethering origin 

coordinates (use 0.0 0.0 0.0 for the centre of the box). Then click Update 

to implement the changes 
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6. Simulation Box tab 

 

The Simulation Box tab is used to create the box, make changes to the box parameters and, after 

the box has been created, implement any changes made in the Components tab to all the 

components in the box. In the top left hand corner, there is a table of all the specified components 

and four methods to create/place the components in the simulation box. Remember to make the 

box size big enough (by adding sufficient components to the box) so as half the length of the box is 

larger than the largest g(r) to be studied. 

 

6.1. Mixato 
This puts the specified number of each component at the centre of a box that is of a size determined 

from the atomic number density. Note that all the molecules are positioned on top of each other 

and have their starting conformation therefore it is necessary to click Randomise to distribute the 

components randomly around the box and then click Run fmole (e.g. 10,000 iterations). Fmole runs 

in an external window so the simulation can be prepared further while it is running. 
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6.2. Addato 

 

This adds the number of each component specified in the ‘# in box’ column to the container 

specified in the dropdown list. The size of the container determines the size of the resulting 

simulation box. The atomic number density is calculated after the box has been built. Note that 

there can only be 1 component per .ato file in the .ato files to be added to the container. The 

components are added at random to the container. If a component in the container is tethered, its 

epsilon and sigma are used together with the epsilon and sigma of the added component(s) to 

determine the distance at which the nearest components can be added, thus preventing overlap of 

the tethered container components and the added components. If there is not enough space to add 

all of the added components, then some will be missed out. The final number of components added 

will be shown in the composition window which opens when Addato has finished. If Addato is 

completely unsuccessful and could not find enough space to add any of the components to add, the 

process is aborted and an error message is shown. 

 

6.3. Load box 
Loads a simulation box .ato file made elsewhere. Make sure the names of the .mol files are at the 

bottom of the box .ato file (in place of moltypeXX) so that changes made to the .mol files are 

implemented to the box on running fmole. Rename the box .ato file to <projectname>box.ato, click 

Load box and select the box .ato file. If the box .ato file is in a different directory it will be copied to 

the current project directory. Ensure the component files are present in the project directory before 

starting Load box – they will be automatically loaded into the project when Load box finishes. 

 

6.4. Create molecular lattice 

 



 

Se
ct

io
n

: 
Si

m
u

la
ti

o
n

 B
o

x 
ta

b
 

24 

 

In the dialog box that opens, select the component or box .ato file to be expanded a specified 

number of times along each axis. The lattice is then used as the simulation box. Only one component 

can be made into a lattice; to add additional components to the simulation box, use Addato. 

 

6.5. Simulation box details 
Once the simulation box has been created, details about it are given in the lower half of the 

Simulation Box tab. Default values are used on creating the box - to make changes to the simulation 

settings, change the following values and then click Update box: 

Parameter Description 

Temperature Temperature the data were collected at. Default 300. 

Vibtemp Degree of bond distance restraint; default 65 is usually appropriate. Increase value 

to increase rigidity (or vice versa). Run fmole after Update box. 

Angtemp Degree of bond angle restraint; default 1. Linked with Vibtemp therefore an 

increase in Vibtemp will also increase the rigidity of bond angles. Use a larger value 

to increase bond angle rigidity without increasing bond distance rigidity (or vice 

versa). Run fmole after Update box. 

Dihtemp Degree of dihedral angle restraint; default 10. Linked with Vibtemp therefore an 

increase in Vibtemp will also increase the rigidity of dihedral angles. Use a smaller 

value to decrease dihedral angle rigidity without decreasing bond distance rigidity 

(or vice versa). Run fmole after Update box. 

Ecore Energy for intramolecular distance restraint; 0 means not used, >0 means the 

distance specified in dcore will be implemented.  

Dcore Minimum intramolecular distance between atoms in Å; requires a non-zero ecore 

value to be used. 

Step sizes View and edit the step sizes used to move components during EPSR (Å) by clicking 

the Step sizes button. 

Tethering Any tethered components in the box is tethered are shown on clicking the 

Tethering button. To un-tether a component, type F in the Tethered? column and 

delete the text in the Tether atom column. To tether a component, type T in the 

Tethered? column and type 0 (zero) in the Tether atom column to use the centre of 

mass of the component, or the numerical atom label to specify an atom as the 

point to tether. Type a small number for the Tethering tolerance (e.g. 0.1; the 

smaller the number, the stronger the tethering). 

 

After the simulation box has been created, if any changes are made to the components in the 

simulation box (via the Components tab) it is necessary to Run fmole to apply the changes to all the 
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components throughout the box. The number of iterations is dependent on the system and the 

changes made. For more details on fmole refer to the EPSR manual. 

Composition shows the number of each atom type present in the simulation box. 

Reload box reads the simulation box file and refreshes the parameters listed in the Simulation box 

details section; use after Run changeato for box. 

Remove component removes a single specified component from the simulation box. If weights files 

already exist for the simulation box and then a component is removed, it is imperative that the 

scattering weights files are remade (see Section 7) before proceeding with the simulation. 

For any additional changes not listed here, click Run changeato for box - note that this will run 

changeato in a command prompt/terminal window. 
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7. Data and Weights tab 

 

In the Data and Weights tab the data files that the simulation box will be refined to are added to the 

project. Details about the sample that each dataset was collected from are inputted and the 

associated scattering weights files are prepared in accordance with this information. The weights 

files are used to calculate the ‘theoretical’ structure factor equivalent to each dataset for the 

simulation box. 

 

7.1. Data files 
The first section of the Data and Weights tab is concerned with adding datasets to the project; the 

first parameter that needs to be specified is whether the dataset was collected using neutrons or X-

rays. On clicking Browse, EPSRgui will show the default files produced by GudrunN and GudrunX 

(.mint01 and .int01 respectively) depending on the radiation selected. For other file types, use the 

dropdown menu in the Browse window to show all file types (*.*). EPSRgui will copy data files into 

the project folder as necessary; the data file used in the project is the one in the project folder. By 

default, EPSRgui assumes the data file is in the Gudrun format; if the data file was not produced by 
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Gudrun, refer to the EPSR manual for each of the file types and then edit the Edit data files tab in the 

EPSR Input File tab once the EPSR input file has been created (Section 8.2). 

 

7.2. Scattering weights 
In the second section of the Data and Weights tab, the scattering weights files are created and 

edited. For neutron data, Gudrun normalises the data to a standard scatterer by default and then 

offers additional options to normalise the data further to <b2> or <b>2. Therefore, if standard 

Gudrun processing for neutron data has been used then select ‘nothing’ in the Normalise totals to 

drop box. For X-ray data, select the normalisation method used during data correction and 

processing. 

In the Scattering Weights table, the Atom Types column contains a list of the each atom type present 

in the simulation box (these atom types are the same as those in the Components tab, but are for all 

of the components in the simulation box). For X-ray data, independent atom form factors are 

applied automatically so the weights file can be made immediately by clicking Make .wts file. For 

neutron data, further details about the sample that the dataset were collected from need to be 

inputted. For a sample containing hydrogen atoms, exchangeable hydrogen atoms are specified by 

typing ‘1’ in the Exchangeable? column (use ‘0’ for non-exchangeable). Neutron data also require 

the isotope of each atom type to be defined. The following table illustrates how this is done for 

hydrogen atoms: 

 Isotope Abundance Isotope Abundance 

All natural hydrogen 0 1   

All deuterium 2 1   

50:50 H:D 0 0.5 2 0.5 

 

Atom types that are natural abundance isotopes are always represented by ‘0’ in the first Isotope 

column and ‘1’ in the first Abundance column. Once all the details about the sample have been 

inputted, click Make .wts file. This will show the normalisation code in the Normalisation column in 

the Data Files table and the name of the weights file in the Wts File column. If the Wts File column is 

empty, the weights file has not been created. To make changes to the scattering weights for a 

particular dataset, click on the dataset, make any changes in Scattering Weights table and then click 

Make .wts file. Any changes made are not saved until the Make .wts file button is clicked. 

To remove a dataset before the EPSR input file has been created, click Remove selected.  

If a scattering weights setup file already exists for a dataset that is added, a message will appear 

asking whether to make a new scattering weights setup file or to overwrite the existing weights 

setup file. If no changes have been made to the composition of the simulation box, an existing 

weights setup file can be used, but to be certain that the weights file produced is consistent with the 

simulation box, it is recommended that a new scattering weights setup file is created. 

All of the datasets added to the Data and Weights tab will be used when creating the EPSR input file. 

If a change is made to the weights files after the EPSR input file has been created, use ireset and iinit 

in the EPSR input file to reset and re-initialise the simulation as the weights files need to be read in 
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again before continuing. If an additional dataset needs to be added after the EPSR input file has 

been created, the EPSR input file must first be deleted (Section 4.2.2) before the dataset can be 

added and the EPSR input file re-created (Section 8). If a dataset needs to be removed after the EPSR 

input file has been created, either first delete the EPSR input file (Section 4.2.2) or change the EPSR 

input file to not refine to the dataset (Section 8). This method can also be employed when using a 

dummy dataset that the simulation box is not refined to, but the structure factor from the 

simulation box is still calculated. 
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8. EPSR Input File tab 

 

In the EPSR Input File tab, the EPSR input file can be created in accordance with all of the 

parameters detailed in the previous tabs by clicking Setup EPSR input file. Any changes made in this 

tab are automatically saved on running EPSR, or can be saved manually by clicking Save Changes. It 

is not possible to make changes to this tab while EPSR is running. To see any changes to the EPSR 

input files while EPSR is running click Reload. To automatically show changes to the EPSR input file 

while EPSR is running tick Auto update. Once EPSR has stopped, the latest changes to the EPSR input 

file are shown automatically.  

 

8.1. Edit input file 
The EPSR input file contains information about the simulation as well as parameters used to run 

different aspects of the simulation. Of particular importance are: 
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Parameter Description 

ireset ‘1’ by default when starting the simulation. If changes to the weights files are 

made, change to ‘2’ before restarting the simulation. To use ereqstep, change to ‘2’ 

for the first iteration. 

iinit ‘1’ by default when starting the simulation. It generally is left at ‘0’ after this unless 

the simulation is completely reset (‘ireset 1’). 

sizefactor The first value represents the factor the box size is multiplied by and is used to 

expand the box if one of the components is particularly bulky or contains a ring. 

This allows the components to move around the box so as their atoms are not 

overlapping before the box size is reduced to normal size over successive EPSR 

iterations. 

ereq The amount of energy given to the empirical potential to overcome the reference 

potential. ‘0’ means the empirical potential is not refined. A non-zero number 

means the empirical potential is refined. The size of ereq is dependent on the 

system being studied and can be changed manually or refined to an optimum value 

using ereqstep. 

ereqstep ‘0.0’ means ereqstep is not used. To refine ereq to provide the best fit of the 

simulation box (model) to the data, change ereqstep to  ‘1.0’ and change ireset to 

‘2’. Run EPSR. The value of ereq will increase by a step size dependent on the 

values of sfreq (see below) for an initial assessment before moving on to automatic 

adjustment of ereq. To stop refining ereq, change ereqstep back to ‘0.0’. 

sfreq The first value is the number of iterations performed while EPSR performs an initial 

assessment during which the empirical potential is increased to a number of 

multiples of kT defined by the second value of sfreq. Increase the second value of 

sfreq when larger values of ereq are required in order for the empirical potential to 

have any effect on the simulation. If changing the second value of sfreq after 

having already started refining the empirical potential, also change iinit to ‘1’ 

before restarting the simulation. This will use the existing empirical potential as a 

starting point and will perform the initial assessment followed by automatic 

adjustment from this point. To reset the empirical potential back to zero and start 

the initial assessment followed by automatic adjustment from zero, set ireset to 

‘2’. 

nsumt Once the simulation has been improved as much as possible, each frame from each 

iteration of the simulation can be accumulated to build an average model of the 

simulation box. ‘-1’ means frames are not being accumulated. Use ‘0’ to start 

accumulation. The number given in the Value column after accumulation has 

started then shows the number of frames accumulated. 

Further information on refining the empirical potential is given in the Tutorials (Section 11) and in 

the EPSR manual. See Tutorials 5 and 6 (Section 11) for more information on parameters that need 

to be changed in order to calculate Bragg peaks for samples with long range order. 
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8.2. Edit data files 
The keywords of importance in this tab are: 

Parameter Description 

nrtype Default is ‘5’ for data corrected and processed in Gudrun. See EPSR manual for 

code to use with alternative available formats. 

efilereq Use ‘1.0’ to refine to the dataset, use ‘0.0’ to not refine to the dataset and just 

calculate the structure factor from the simulation box according to the scattering 

weights and radiation detailed in the Data and Weights tab. 

szeros The minimum Q value for the data; ‘0.0’ means use the first point in the dataset, a 

non-zero value will be used as the Qmin. 

rshmin The minimum r value for background subtraction prior to the fourier transform. 

Generally, for hydrogen containing systems, 0.7 Å is appropriate as it does not clip 

the first peak for the X-H bond. 

 

 

8.3. Edit .pcof file 
The pcof file contains information regarding how the reference and empirical potentials are 

manifested in the simulation and is generally for more advanced settings. See Tutorials 5 and 6 

(Section 11) for more information on parameters that need to be changed in order to calculate Bragg 

peaks for samples with long range order. 

 

8.4. Edit minimum distances 
The minimum intermolecular distances between pairs of atom types can be specified in Å. This can 

be used to prevent atoms from approaching too closely when just using their Lennard-Jones 

parameters and charges. 
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9. Analysis tab 

 

The Analysis tab enables analysis routines and density function plots to be setup once the simulation 

is a good fit to the data. To do this, EPSR must first be stopped, analysis routines that are added to 

the Running in EPSR list will then run while EPSR is running. 

 

9.1. EPSR analysis routine setup 
Here, each of the Analysis routines outlined in the EPSR manual can be setup. Refer to the EPSR 

manual for more information regarding what each routine does. After selecting a routine type in the 

Analysis routine dropbox, input a name for a new routine in the New analysis routine line and click 

Setup. In the window that appears, fill in the details about the routine. For a routine that can have 

more than one calculation, use the Add calculation button to add more calculations, and the 

Remove calculation button to remove the calculation. Click on the calculation in the list to view and 

edit its parameters. Once finished, click Save. The routine will now be listed in the Existing routines 

list in the EPSR analysis routine setup box. To make changes to the routine, select it from the list and 

click Setup. To cancel the changes click Cancel. To cancel and delete the routine click Cancel and 
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Delete (this cannot be undone). To add the analysis routine to be run while EPSR is running click the 

>> button (stop the routine from being run using <<). Note that if any changes are made to the 

routine after it has been run in EPSR, then nsumt for the routine should be changed to ‘0’ as 

otherwise part of the calculation will be done using one set of values and the other part using a 

different set of values. The results from the analysis routines can be viewed using Plot data in the 

Plot menu on the Menu bar (see Section 4.4.2). 

 

9.2. EPSR density plot setup 
Here, the plotting routines which offer the tools to plot a density function calculated using an 

analysis routine can be setup (the analysis routine must first have run for at least one iteration 

before the plotting routine can be setup). After selecting a routine type in the Plotting routine 

dropdown menu, input a name for a new routine in the New plotting routine line and click Setup. In 

the window that appears, fill in the details about the routine. Once finished, click Save. The routine 

will now be listed in the Existing routines list in the EPSR plotting routine setup box. To make changes 

to the routine, select it from the list and click Setup. To cancel the changes click Cancel. To cancel 

and delete the routine click Cancel and Delete (this cannot be undone). To run the plotting routine, 

click Density Plots in the Plot menu on the Menu bar and select the plotting routine type (see 

Section 4.4.4). 

To write an accumulated file of many frames of the simulation for analysis with the dlputils package, 

tick Output for dlputils and click Apply to write the .xyz file while also incrementing nsumt in the 

EPSR input file. 

 

9.3. Output for dlputils 
Ticking this box writes an .xyz file (called <project name>boxappend.xyz) that contains the atom 

positions for all of the atoms in the box for every frame of the simulation that is run while the box is 

ticked. This is a large file that is for use with the dlputils package 

(https://www.projectaten.com/dlputils). 

 

9.4. Additional commands 
In the Additional command lines box, extra commands can be included that will run after each EPSR 

iteration. These should be written in the command line format for Windows or the shell terminal 

format for Linux and Mac. Click Apply to include them while running EPSR. 
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10. Methodologies 
The following are some example methods that can be used to create a variety of different systems 

from simple liquids to porous materials: 

• Simple liquid 

– Create/load component 

– Mixato 

• Network glass 

– Create/load component 

– Mixato 

• Network glass from lattice 

– Makelattice – tick ‘use as simulation box’ 

– Change ‘Tethered?’ to ‘f’ in tethered components table, Simulation box details 

• Molecular glass from lattice 

– Create component .mol and .ato and lattice .ato in external software and save to 

project folder 

– Ensure component is listed at bottom of lattice .ato file 

– Load box 

– If necessary, untether in Simulation box details 

• Crystalline porous material 

– Create lattice .mol and .ato in external software 

– Load box 

– Tether lattice in Simulation box details 

• Loaded crystalline porous material 

– Create lattice mol and ato in external software 

– Create/load .mol file for added molecule 

– Addato (using lattice as container) 

• Amorphous porous material 

– Make a lattice of Q points 
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– Create/load components for amorphous material 

– Addato (using Q lattice as container) 

• Loaded amorphous porous material 

– Follow above method and refine to data to make the amorphous porous material 

– Create/load components for loaded molecules 

– Addato (using box as container) 

• Liquid with nanoparticles present 

– Create lattice .mol and .ato in external software, and increase the box size to 

produce the correct density of the final system.  

– Create/load the liquid component 

– Addato (using the lattice as the container) 
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11. Tutorials 
In the following pages there are two glass tutorials and two liquid tutorials. It is recommended to 

work through them in order as the later tutorials are more of a guide than step-by step instructions. 

Data for the tutorials are found in the Resources folder in the EPSRgui distribution. 

 



SiO2 

EPSRgui tutorial 1 



Purpose of this tutorial 
 
The goal of this tutorial is to build, 
refine and analyse a model of a simple 
oxide glass, SiO2. To achieve this, the 
tutorial will cover how to: 

• Create the atomic components 
and define their Lennard-Jones 
potentials. 

• Create a simulation box containing 
the components. 

• Create scattering weights files for 
each of the experimental datasets. 

• Create a simulation and run it. 

• Improve the Lennard-Jones 
potentials as required. 

• Refine the empirical potential. 

• Create analysis routines to probe 
the simulation. 

• Run analysis routines and 
accumulate the distribution 
functions. 

• Plot the results. 

 

 

2 



Create a new project 
 

• On the top menu bar, click File -> 
Create new project… 

• The directory for the new project 
will be in the ESPR run folder (as 
setup during installation). 

• Type the name for the new 
project, e.g. SiO2tut. 

• Click OK. 

• If a project already exists with this 
name an error message will 
appear as two projects cannot 
have the same name – use a 
different name for the new 
project. 

• All files associated with this 
simulation will be saved to the 
SiO2tut folder in the run directory. 

• The project can be reopened by 
opening the SiO2tut.EPSR.pro file 
within EPSRgui. 
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Create atom components 
 
• First the components of the box need 

to be created. In this case these are 
the Si and O atoms. 

• In the Components tab, click the 
Create single atom button. 

• In the window that appears, enter 
the values given adjacent for a silicon 
atom and click OK. As SiO2 is a 
covalent glass, partial charges are 
used to mimic the covalency and 
expected stoichiometry. 

• The details for Si are then shown in 
the bottom section of the 
Components tab. 

• Click Create Single atom again and fill 
out the fields this time for an oxygen 
atom. 

• The Components tab now shows 
Si.mol and O.mol in the list of 
components to include in the 
simulation box. 

• To view the parameters for each 
component click on the chosen 
component in this list.  
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Create the simulation box 
 
• Click on the Simulation Box tab 
• The components and their respective 

charges are shown in the Create 
simulation box table. 

• Enter the number of each 
component to be included in the box. 
In this instance enter 1000 for Si and 
2000 for O (double click on the cell to 
edit it). 

• Enter the atomic number density of 
the system – this is 0.0664 atoms/Å3. 

• Then click Mixato. This creates a 
cubic simulation box with the given 
number of each component. The size 
of the box is determined by the 
number of atoms and the atomic 
number density and is given in the 
Simulation box details at the bottom 
of the tab. Sufficient components 
should be added to the box so that 
half the box length is longer than the 
longest correlation to be assessed in 
the simulation. 

• The details about the simulation box 
are shown in the lower part of the 
window. 

• To distribute the components 
randomly throughout the box, click 
Randomise. 
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Data and scattering 
weights 
 
• For EPSR to correctly calculate the 

structure factor from the simulation 
box for a given experimental dataset, 
scattering weights files need to be 
created that identify whether the 
experimental data are from neutrons 
or X-rays, which atoms are 
isotopically substituted and whether 
any of the atoms can exchange. 

• Click on the Data and Weights tab. 

• Select X-ray dataset and click Browse. 

• Navigate to the SiO2_Ag_XRD.int01 
dataset in the EPSRgui\Resources 
folder and click Open. 

• Click Make .wts file. The .wts file is 
then shown in the Weights File 
column of the data file table. 

• Now repeat for the neutron dataset. 

• Select Neutron dataset and click 
Browse. Navigate to the 
SiO2_NIMROD.mint01 dataset in the 
EPSRgui\Resources folder and click 
Open. 

• Click Make .wts file. 
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EPSR input file 
 

• The EPSR input file contains the 
parameters which define the 
simulation settings. 

• Click on the EPSR input file tab and 
click Setup EPSR input file. 

• This creates an input file with the 
default settings. It is created using 
the components, simulation box, 
data files and weights files created 
in the last steps. 

• The details contained in the input 
file are listed in the tabs. For this 
tutorial, the default settings are 
fine to get the simulation started 
so nothing needs to be edited. 
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Running EPSR 
 
• It is now time to run EPSR: on the top 

menu bar click Run…-> Run EPSR. 

• On the bottom right hand corner an 
‘EPSR running’ sign is shown, and in 
the command prompt/terminal 
window various messages are shown 
while EPSR runs. 

• While EPSR is running the simulation 
cannot be edited. 

• Wait about 30s and then stop EPSR: 
on the top menu bar click Run…-
>Stop EPSR. 

• EPSR will stop once it has finished the 
current iteration - once finished the 
sign in the bottom right hand corner 
will turn grey and say ‘EPSR not 
running’. 

• In the Messages window (Settings-
>Show messages) the results of the 
final iteration are shown. 

• The EPSR input file will be 
automatically reloaded with the 
values from the last iteration and the 
plots on the right hand side of the 
screen will also update. 
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Examining the simulation 
 
• Once the simulation has 

performed one iteration several 
aspects of the simulation can be 
viewed. 

• On the right hand side of the 
screen, there are two plots which 
show the data and calculated 
structure factor for the model 
(F(Q)). As the simulation has only 
just started, the fit will be quite 
poor but the calculated values 
from the model should bear some 
resemblance to the data. 

• To view the radial distribution 
function for the model and the 
data click on the drop down menu, 
choose G(r) and then click Plot. 

• Other aspects of the simulation 
such as Energy or R-factor can also 
be plotted by selecting from the 
drop down menu and clicking Plot. 
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Proceeding with the 
simulation 
 
• The Energy plot shows that the 

energy has reduced to such a small 
value that it is barely visible on the 
plot. This is because the components 
were initially placed randomly in the 
box but have now been moved to 
more appropriate positions owing to 
the reference potential defined by 
the Lennard-Jones parameters. 

• To use this configuration as the new 
starting point, in the EPSR input file 
tab, change the value of ireset to 2. 

• Then run EPSR again by clicking 
Run…->Run EPSR. Any changes made 
to the input file are automatically 
saved on running EPSR. 

• Choose Energy in one of the plot 
drop down menus and click Plot. 

• You can now see that the energy is 
negative and (after ~50 iterations) 
following a downward trend. 
However, the R-factor plot is not 
improving… 

• To refresh the graph click Plot again. 
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Improving the simulation 
– the reference potential 
 
• On examining the simulation, it can be seen 

that the peaks for the model F(Q) are not 
fitting the data as they are shifted to the left 
or right.  In r-space it can be seen that the 
Si-O bond distance is too short in the model 
compared to the data (1.6 Å) as the peak is 
shifted to the left. This suggests that the 
Lennard-Jones parameters of the 
components are not appropriate as they are 
not allowing the atoms to approach in a 
manner that fits the data. 

• Now try using the optimised Lennard-Jones 
potentials given in the adjacent table - first 
stop EPSR (if necessary) and then, in the 
Components tab, edit the epsilon and sigma 
values for the silicon and click Update. 
Repeat this for the oxygen and click Update.  

• In the Simulation Box tab Run fmole 10000 
times to apply the changes to the 
simulation box. 

• Run EPSR again – see how the new values 
influence the peak positions and if the fit 
has improved. 

• Equilibrate the box by running the 
simulation until the r-factor and energy 
plateau. 
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O 0.165 3.5 



Improving the simulation 
– the empirical potential 
 
• Once the fit is as good as can be 

obtained from the reference 
potential alone, it is time to start 
refining the empirical potential. 

• First, stop EPSR. 

• In the EPSR input file tab, change the 
ereqstep value to be 1 and the sfreq 
value to be 50 10. Also, change the 
ireset value to be 2. 

• Run EPSR again. 

• EPSR will now be refining the 
empirical potential so as to allow the 
atoms to move in such a way as to 
get a better fit to the data. The 
amount of energy EPSR uses to 
achieve this is decided by EPSR by 
assessing what the recent 
improvement to the fit has been for a 
certain energy value. This can be 
plotted by selecting ereq from the 
plot drop down menu and clicking 
Plot. 

• Make a note of the value of the ereq 
energy at which the quality of fit is 
best. 

Read off an approximate 
lowest energy value that 
provides the best fit (in 
this case, ~300). 
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Accumulating the refined 
simulation box 
 

• Once the simulation has been 
improved as far as possible, and a 
good value for ereq has been 
identified, stop EPSR. 

• In the EPSR input file tab, change 
ereq to the best value identified 
from the ereq plot. Also change 
ereqstep to be 0.0. 

• To start accumulating the positions 
of the atoms over a number of 
frames of the simulation (in order 
to improve statistics for the pair 
correlation functions etc), change 
the value of nsumt to be 0. 

• We also want to set up analysis 
routines so that they will be 
performed on each frame of the 
simulation while EPSR is running. 
Before we know what to setup we 
need to take a look at the 
simulation so far… 
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Analysing the refined 
simulation box – g(r) 
 
• On the top menu bar, click Plot->Plot data. 

• In the plotting window that opens, click g(r) 
inter to plot the intermolecular pair 
correlation functions for selected atom pairs. 

• Click on each atom in a pair and click the > 
button to add the pair to the list of pair 
correlation functions to be plotted. Repeat 
this for each atom pair to be plotted. To 
remove an atom pair, click on it and then click 
the < button. 

• Then click Plot. 

• This plots the intermolecular g(r) together 
with the coordination number (in grey). 

• To re-position the plot, right click and drag. To 
zoom in and out use the mouse roller wheel. 
To zoom in and out along the vertical axis 
only, hold down Ctrl while using the mouse 
roller wheel. To zoom in and out along the 
horizontal axis only, hold down Shift while 
using the mouse roller wheel. 

• The most commonly occurring nearest 
neighbour distance can be read off from the 
first peak maximum. Make a note of the 
maximum r value which could still be 
considered the nearest neighbour for each 
g(r) (usually the end of the 1st peak or the 1st 
minimum). 
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Calculations from the refined 
simulation box – coord 
 

• Click on the Analysis tab. 

• In the Analysis routine drop down 
menu, select Coord. 

• In the New analysis routine name 
type CN and click Setup. 

• In the dialog window that appears 
change the following values 

• nsumt: 0 

• atom1: Si 

• atom2: O 

• rmax: <read off from g(r) plot> 

• Press Save. 

• The analysis routine file CN will 
now appear in the Existing analysis 
routines box. Click the >> button 
to add it to be run when EPSR 
runs. 
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Calculations from the refined 
simulation box – triangles 
 

• Click on the Analysis tab. 

• In the Analysis routine drop down 
menu, select Triangles. 

• In the New analysis routine name 
type SiO2 and click Setup. 

• In the dialog window that appears 
change the following values 

• nsumt: 0 

• atom1: O 

• atom2: Si 

• atom3: O 

• rmax12: <read off from g(r) plot> 

• rmax23: <read off from g(r) plot>  

• Press Save. 

• The analysis routine file SiO2 will 
now appear in the Existing analysis 
routines box. Click the >> button  
to add it to be run when EPSR 
runs. 
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Performing  
analysis routines 
 
• Once all the analysis routines have 

been set up, run EPSR. 
• Even while EPSR is running, the 

outputs from the analyses can be 
viewed by clicking Plot->Plot data. 

• In the top right hand corner, the 
analysis routines that have been 
running are listed. 

• Click on the CN.COORD calculation 
and click Options on the bottom right 
hand corner. This opens additional 
plotting options. 

• Select the atom pair you want to see 
the coordination number for in the 
list in the Plot type specific options 
box and then click Plot. 

• This shows a histogram of the 
normalised number of instances that 
each coordination number is 
observed in the accumulated frames 
of the simulation (as defined during 
setting up the routine). 

• Repeat this for the triangles (TRI) 
calculation. 

• This shows a histogram of the 
normalise number of instances that 
each angle is observed in the 
accumulated frames of the 
simulation (as defined during setting 
up the routine). 
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Methanol 

EPSRgui tutorial 2 



Purpose of this tutorial 
 

The goal of this tutorial is to build, 
refine and analyse a model of a simple 
liquid, CH3OH. To achieve this, the 
tutorial will cover how to: 

• Create the molecular component 
and define the Lennard-Jones 
potentials for each atom type. 

• Create a simulation box containing 
the component. 

• Create scattering weights files for 
each of the experimental datasets. 

• Create a simulation and run it. 

• Refine the empirical potential. 

• Create analysis routines to probe 
the simulation. 

• Run analysis routines and 
accumulate distribution functions. 

• Plot the results. 
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Create a new project 
 
• On the top menu bar, click File -> 

Create new project… 

• The directory for the new project 
will be in the ESPR run folder (as 
setup during installation). 

• Type the name for the new 
project, e.g. MeOHtut. 

• Click OK. 

• If a project already exists with this 
name an error message will 
appear as two projects cannot 
have the same name – use a 
different name for the new 
project. 

• All files associated with this 
simulation will be saved to the 
MeOHtut folder in the run 
directory. 

• The project can be reopened by 
opening the MeOHtut.EPSR.pro 
file within EPSRgui. 
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Create the molecular 
components 
 
• First, the methanol molecule needs to be 

constructed. 
• In the Components tab, click Create new. 
• In the window that appears, MOPAC can be 

used (provided it is installed) to optimise the 
molecular geometry once the component 
has been created. To opt to do this, choose a 
MOPAC option (AM1 or PM3 are 
recommended) and then click OK. 

• In the Jmol window that appears click on the 
atom icon and a carbon atom with 4 
hydrogens attached to it will appear. 

• Right click on the black background and on 
the atom menu tick O. 

• Left click on one of the hydrogen atoms to 
change it to a hydroxyl group. 

• Right click on the black background and in 
the … menu click minimise. Repeat this a 
couple of times. 

• Right click on the black background and in 
the … menu click save file. 

• In the Save dialog, save the file as a 
MeOH.jmol. It is very important to save this 
as a .jmol, DO NOT SAVE IT AS A .mol file. 

• Click Save. 
• Close the Jmol window. 
• If MOPAC has been run, check the 

calculation has been successful by checking 
the output given at the bottom of Settings-
>EPSR messages. 
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Define the Lennard-Jones 
potentials 
 
• The .jmol file just saved has now been 

converted into an EPSR .mol file and is 
shown as a component to be included in 
the simulation box. 

• In the Atom types table, the Label gives the 
number of each atom in the molecule – this 
number is unique to each atom. In the 
adjacent column is the atom Type – this is 
usually a letter and a number and is not 
necessarily unique. In this example, the 
methyl hydrogen atoms all have the same 
type which means they will all have the 
same reference potential. As they have the 
same environment, this is fine for this 
simulation. 

• Default Lennard-Jones potentials for each 
atom type are given in the Define 
component box. 

• Edit the Lennard-Jones potentials and 
charges to be consistent with the potentials 
and charges given by Jorgensen et al. and 
click Update. 

• Check that the charge shows the molecule 
is neutral. 

• Bond distances, bond angles, dihedral 
angles and rotational axes can also be 
defined. 

• As the methyl group can rotate freely and 
the hydroxyl group can rotate freely, make 
sure there are no dihedral angles. Click on 
the Dihedral Angles tab and if anything is 
listed in the table, click Delete All. Then 
click Update. 
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Create the simulation box 
 
• Click on the Simulation box tab. 
• Enter the number of methanol 

molecules to be included in the box. In 
this instance enter 500. 

• Enter the atomic number density of the 
system – this is 0.0886 atoms/Å3. 

• Then click Mixato. This creates a cubic 
simulation box with the given number 
of each component. The size of the box 
is determined by the number of atoms 
and the atomic number density and is 
given in the Simulation box details at 
the bottom of the tab. Sufficient 
components should be added to the 
box so that half the box length is longer 
than the longest correlation to be 
assessed in the simulation. 

• To distribute the components randomly 
throughout the box, click Randomise. 

• To add some disorder to the molecule 
to represent the thermal motion of the 
atoms, click Run fmole (10,000 
iterations are recommended). The 
amount of disorder is controlled by 
Vibtemp (see manual) –  65 is generally 
appropriate, but if vibtemp or any 
other parameters in the Simulation box 
details are changed, Run fmole in order 
for the change to be applied 
throughout the simulation box. 
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Data and scattering 
weights 
 
• For EPSR to correctly calculate the structure 

factor from the simulation box for a given 
experimental dataset, scattering weights 
files need to be created that identify 
whether the experimental data are from 
neutrons or X-rays, which atoms are 
isotopically substituted and whether any of 
the atoms can exchange. 

• Click on the Data and Weights tab. 

• Select Neutron dataset and click Browse. 

• Navigate to the cd3od.mint01 dataset and 
click Open. 

• As this is a fully deuterated sample, change 
the methyl hydrogens, H1, to 2 in the 
isotope column. The abundance is 1 as all 
of the H1 atoms are deuterated. 

• As the hydroxyl hydrogen can exchange, 
change H2 to 1 in the exchangeable 
column, and as it is deuterated, change the 
isotope to 2 (again this is fully deuterated 
so the abundance is 1) 

• Click Make .wts file. 

• Repeat this for the cd3oh.mint01 and 
ch3od.mint01 datasets, but using the 
appropriate isotopes for dataset. For a 
50:50 H:D sample the first isotope is 0 as it 
is natural hydrogen and the abundance is 
0.5, the second isotope is 2 as it is 
deuterium and the abundance is 0.5. 
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EPSR input file 
 

• The EPSR input file contains the 
parameters which define the 
simulation settings. 

• Click on the EPSR input file tab and 
click Setup EPSR input file. 

• This creates an input file with the 
default settings. It is created using 
the components, simulation box, 
data files and weights files created 
in the last steps. 

• The details contained in the input 
file are listed in the tabs. If this 
molecule contained rings, e.g. a 
phenyl ring, it would be 
recommended to change size 
factor to 5.0 0.9 0.0 so as to 
temporarily expand the box to 
prevent the rings interlocking. 
However, for methanol, the 
current settings are fine. 
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Running EPSR 
 

• It is now time to run EPSR: on the 
top menu bar click Run…-> Run 
EPSR. 

• After a few seconds, plot the data 
in reciprocal space and real space 
and examine the decrease in 
energy and r-factor using the plots 
on the right hand side of the 
window. 

• Wait about 30s and then stop 
EPSR: on the top menu bar click 
Run…->Stop EPSR. 

• Once EPSR has finished the last 
iteration and stopped, change 
ireset to 2 and run EPSR again. 

• Replot the energy to see if it is 
negative and still decreasing - to 
refresh the graph click Plot again. 

• Continue running EPSR until the 
Energy and R-factor plots plateau 
(they do not need to be smooth). 
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Improving the simulation 
– the reference potential 
 
• After the box has equilibrated as far 

as possible without the empirical 
potential, stop EPSR and examine the 
simulation. 

• In real space, are the peak positions 
at low r (=bond distances) correct? 
Are the first peak heights (=scattering 
weights) correct? In reciprocal space, 
are the peak positions approximately 
correct? 

• If these are all approximately ok 
(which they should be), move on to 
refining the empirical potential. 

• If not, edit the Lennard-Jones 
potentials in the Components tab, 
and click Update. 

• Run fmole 10,000 times to apply the 
changes to the simulation box. 

• Run EPSR again and see if this 
improves the fit. 

• If a mistake has been made during 
making the weights files, correct it in 
the Weights files tab and click Make 
.wts file. In the EPSR input file tab, 
change ireset to 2 and then run EPSR 
again. 
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Plot simulation box 
 

• It is a good idea to check that the 
molecules are behaving as would 
be expected in the simulation box. 

• On the top menu bar click Plot-> 
Plot simulation box. 

• In the dialog box select any atoms 
that you want to EXCLUDE from 
the plot – in this instance plot all 
the atoms. 

• Click Plot box. The simulation box 
will open in a Jmol window. 
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Improving the simulation 
– the empirical potential 
 
• Once the fit is as good as can be 

obtained from the reference potential 
alone, it is time to start refining the 
empirical potential. 

• If necessary, stop EPSR. 
• In the EPSR input file tab, change the 

ereqstep value to be 1 and check sfreq 
is 50 1. Also, change the ireset value to 
be 2. 

• Run EPSR again. 
• EPSR will now be refining the empirical 

potential so as to allow the atoms to 
move in such a way as to get a better fit 
to the data. The amount of energy EPSR 
uses to achieve this is decided by EPSR 
by assessing what the recent 
improvement to the fit has been for a 
certain energy value. This can be 
plotted by selecting ereq from the plot 
drop down menu and clicking Plot. 

• You may find that the empirical 
potential is not necessary, or that the 
iterative method does not find a 
minima. If this is the case try using a 
fixed value for ereq with ereqstep 0 and 
manually change the value of ereq – 
check how ereq affects the fit to the 
data by examining the F(Q), G(r), energy 
and R-factor plots. 
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Accumulating the refined 
simulation box 
 

• Once the simulation has been 
improved as far as possible, and a 
good value for ereq has been 
identified, stop EPSR. 

• In the EPSR input file tab, change 
ereq to be the best value identified 
from the ereq plot. Also change 
ereqstep to be 0.0. 

• To start accumulating the positions 
of the atoms over a number of 
frames of the simulation (in order 
to improve statistics for the pair 
correlation functions etc), change 
the value of nsumt to be 0. 

• We also want to set up calculations 
that will give insight into the 
structure so that they will be 
performed on each frame of the 
simulation while EPSR is running. 
Before we know what to setup we 
need to take a look at the 
simulation so far… 
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Analysing the refined 
simulation box – g(r) 
 
• On the top menu bar, click Plot->Plot data. 

• In the plotting window that opens, click g(r) 
inter to plot the intermolecular pair correlation 
functions for selected atom pairs. 

• Click on each atom in a pair and click the > 
button to add the pair to the list of pair 
correlation functions to be plotted. Repeat this 
for each atom pair to be plotted. To remove an 
atom pair, click on it and then click the < 
button. 

• Then click Plot. 

• This plots the intermolecular g(r) together with 
the coordination number (in grey). 

• To re-position the plot, right click and drag, to 
zoom in and out use the mouse roller wheel. To 
zoom in and out along the vertical axis only, 
hold down Ctrl while using the mouse roller 
wheel. To zoom in and out along the horizontal 
axis only, hold down Shift while using the 
mouse roller wheel. 

• The most commonly occurring nearest 
neighbour distance can be read off from the 
first peak maximum. Make a note of the 
maximum r value which could still be 
considered the nearest neighbour for each g(r) 
(usually the end of the 1st peak or the 1st 
minimum). 
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Calculations from the refined 
simulation box – coord 
 

• Click on the Analysis tab. 

• In the Analysis routine drop down 
menu, select Coord. 

• In the New analysis routine name 
type CN and click Setup. 

• In the dialog window that appears 
change the following values 

• nsumt: 0 

• atom1: O1 

• atom2: O1 

• rmax: <read off from g(r) plot> 

• Click Add and in calculation 2 
examine a different combination 
of atoms e.g. O1 C1 with an 
appropriate rmax. 

• Press Save. 

• The routine setup file CN will now 
appear in the existing outputs box. 
Click the >> button to add it to be 
run when EPSR runs. 
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Calculations from the refined 
simulation box – spatial 
density functions 
 

• Click on the Analysis tab. 

• In the Analysis routine drop down 
menu, select Sharm. 

• In the New analysis routine name 
type MeOH and click Setup. 

• In the dialog window that appears 
change the following values 

• nsumt: 0 

• l1: 0 1 2 3 4 

• lvalues: 0 1 2 3 4 

• n1step: 1 

• atom-c: O1 

• axisc1: z 1 6 

• axisc2: x 6 

• atom-s: O1 

• Press Save. 

• The routine setup file MeOH will 
now appear in the existing outputs 
box. Click the >> button to add it 
to be run when EPSR runs. 
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Performing calculations 
 
• Once all the calculations have been set up, 

run EPSR. 

• Even while EPSR is running, the outputs 
from the calculations can be viewed by 
clicking Plot->Plot data. 

• In the top right hand corner, the 
calculations that are running while EPSR is 
running are listed. 

• Click on the CN.COORD calculation and 
click Options on the bottom right hand 
corner. This opens additional plotting 
options. 

• Select the atom pair you want to see the 
coordination number for in the list in the 
Plot type specific options box and then 
click Plot. 

• This shows a histogram of the normalised 
number of instances that each 
coordination number observed in the 
accumulated frames of the simulation (as 
defined during setting up the calculation). 

• To change the maximum x value, type a 
value for x max and then click plot again. 
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Plotting spatial density 
functions 
 
• Now that the sharm routine has been 

run, the coefficients file containing 
the spatial density function of O1 
around O1 has been created. To view 
the information from this routine as a 
surface the plotting routine 
Plot3djmol needs to be setup. 

• Click on the Analysis tab. 
• In the Plotting routine drop down 

menu, select Plot3djmol. 
• In the New plotting routine name 

type MeOH and click Setup. 
• Choose the .SHARM.h01 coefficients 

file created by the previous analysis 
routine. 

• In the dialog window that appears 
press Save. 

• On the top menu bar click Plot->Plot 
outputs->plot3djmol. 

• In the browse window that opens, 
select the .CUBE.txt file  that has the 
same name as the plotting routine  
(MeOH) and click Open. 

• The spatial density function will be 
plotted in Jmol as a surface around 
the average position of the methanol 
molecule. As the methyl group is 
rotating, it is not displayed correctly 
as Jmol is showing the average 
position of the hydrogens. 
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Network glass simulation –  
choose your own! 

EPSRgui tutorial 3 



Purpose of this tutorial 
 
The goal of this tutorial is to build, refine 
and analyse a model of a network glass of 
your choice. Published data from an 
online repository will be used. To build 
this simulation, this tutorial assumes that 
tutorial 1 has been completed and gives 
pointers rather than precise instructions 
in how to: 
• Create the atomic components and 

define their Lennard-Jones 
potentials. 

• Create a simulation box containing 
the components. 

• Create scattering weights files for 
each of the experimental datasets. 

• Create a simulation and run it. 
• Improve the Lennard-Jones 

potentials as required. 
• Refine the empirical potential. 
• Create analysis routines to analyse 

the simulation 
• Run analysis routines and accumulate 

distribution functions. 
• Plot the results. 
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Choose a glass system 
 

• Published experimental data for a 
number of glasses are listed in a 
database at: 

http://alexhannon.co.uk/DBindex.htm 

 

• Click on oxide glasses and choose a 
system that has some 
experimental data. From the 
associated publication referenced 
on the webpage, note the 
composition of the system 
(including density) and how the 
data were normalised. 
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Create a new project and 
add components 
 

• Create a new project via the File 
menu. 

• In the Components tab, make the 
component files using Create 
single atom. 

• If Lennard Jones parameters for 
the components are already in the 
literature, e.g. in Bowron, Procedia 
Materials Science 7 ( 2014 ) 38 – 
52, use these as a starting point for 
the simulation.  

• If not, use the expected bond 
distances to estimate appropriate 
sigma values for the Lennard-Jones 
potentials. The epsilon parameter 
has less effect on the simulation, 
so use something similar to the 
SiO2 simulation as a starting point. 
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Create the simulation box 
 

• Move on to the Simulation Box 
tab. 

• From the atomic composition 
given in the associated publication, 
add the correct ratio of atoms to 
the box. 

• Also from the publication, find the 
density of the sample and convert 
this to atoms/Angstrom3. 

• Ensure enough atoms are added to 
the box so as half the box length is 
larger than the longest g(r) to be 
assessed. 

• Use Mixato to add the atoms to 
the box, and Randomise to 
distribute them randomly 
throughout the box. 

• Check that the box is neutral in the 
simulation box details. 
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Data, scattering weights 
and EPSR input file 
 

• In the Data and Weights tab, add 
each dataset obtained for the 
system, set up and then make the 
weights files. For this, the 
following information is required: 

• Are the data from X-ray or 
neutron scattering? 

• Which isotopes were present in 
the samples (for neutron data) 

• How the data were normalised 

• Once complete, go to the EPSR 
Input File tab and setup the EPSR 
input file. 

• Check what the format of the data 
file is (check the EPSR manual 
[Help->EPSR manual] for more 
information) and change the 
nrtype in Edit data files tab of the 
EPSR Input File tab accordingly. 

• From the menu bar, Run EPSR. 
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Improving the simulation 
 
• Once the energy is negative, stop 

EPSR, reset the simulation (ireset 2) 
and start EPSR again to follow the 
change in energy more easily. 

• Check that the model in reciprocal 
space (F(Q)) and real space (G(r)) 
bears some resemblance to the data. 
If it does not, check that the weights 
files are correct, the composition is 
correct, the density is correct and the 
values used in the component 
Lennard-Jones parameters are as 
expected (e.g. the decimal point is in 
the correct place). 

• If all of the above are correct, use the 
G(r) plot to identify where the first 
nearest neighbours are not fitting 
well. Change the Lennard-Jones 
potentials to improve the fit.  

• Once the simulation has been 
improved as far as possible manually, 
start refining ereq to make the final 
improvements via the empirical 
potential. It is important that the 
reference potential is improved first 
as the energy required to overcome a 
poor reference potential might 
otherwise be unfeasibly large.  
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Accumulating the refined 
simulation box 
 

• Once the simulation has been 
improved as far as possible, 
identify a good value for ereq and 
stop the simulation. In the EPSR 
input file tab use this value of ereq 
as a fixed value and change the 
input file to start accumulating 
frames of the simulation. 

• Identify analysis routines to be 
performed on the simulation while 
it is accumulating (use the EPSR 
manual for more information on 
each routine) and set these up in 
the Analysis tab before running 
EPSR. 

• To perform additional analyses 
after EPSR has started, stop EPSR, 
setup the analysis routine and 
restart EPSR again. Ensure EPSR is 
run for sufficient iterations that 
the results are a good 
representation of the simulation. 
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Viewing outputs and 
analysis routine results 
 

• Most outputs (e.g. pair correlation 
functions) and analysis routines 
can be plotted in the Plot data 
window. 

• For spatial density functions (2D or 
3D) a plotting routine must also be 
setup. Setup plotting routines in 
the lower section of the Analysis 
tab. Refer to the EPSR manual for 
more details on which settings to 
change to achieve this. 
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DMSO-water 

EPSRgui tutorial 4 



Purpose of this tutorial 
 
The goal of this tutorial is to build, refine 
and analyse a model of a the two 
component liquid, DMSO-water. This 
tutorial assumes the methanol tutorial 
has already been completed and gives 
pointers rather than precise instructions 
in how to: 
• Create the molecular component and 

define the Lennard-Jones potentials 
or each atom type. 

• Create a 
•  simulation box containing the 

component. 
• Create scattering weights files for 

each of the experimental datasets. 
• Create a simulation and run it. 
• Improve the Lennard-Jones 

potentials as required. 
• Refine the empirical potential. 
• Create analysis routines to probe the 

simulation. 
• Run analysis routines and 

accumulation the distribution 
functions. 

• Plot the results. 
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Obtain the data and  
system details 
 

Lennard-Jones potentials 
DMSO – see Supporting Information for Jorgensen et al. in 
EPSRgui/Resources and pick the most appropriate potentials.  
SPC-E water: 
 
 
 
 
 
 
Ow-Hw bond distance:  0.976 Å 
Hw-Ow-Hw bond angle: 104.5° 
 
Simulation Box 
Composition: 1 DMSO: 2H2O 
Atomic number density: 0.0919 atoms Å-3 

 
Data and Scattering Weights 
SLS03850.mint01 – neutron, DMSO(D), H2O 
SLS03863.mint01 – neutron, DMSO(D), D2O 
SLS03871.mint01 – neutron, DMSO(D),  (H0.64D0.36)2O 
Data normalisation: totals not normalised 
Data type: 5 
 
References 
• A neutron diffraction study of dimethyl sulphoxide–water mixtures, 

A. K. Soper and A. Luzar, J. Chem. Phys. 97 (1992) 1320. 
• Development and Testing of the OPLS All-Atom Force Field on 

Conformational Energetics and Properties of Organic Liquids, 
Jorgensen et al., J. Am. Chem. Soc. (1996) 118, 11225-11236. 

• The published data are provided in 
the EPSRgui/Resources folder. 

• Note down the composition, 
atomic density and data 
normalisation from the publication 
(shown on the right). 

• In this instance the Lennard-Jones 
parameters are given in the 
publication, but if this was a novel 
system there might not be 
Lennard-Jones parameters so 
readily available. Instead these can 
be obtained/approximated from 
Jorgensen et al. or publications of 
similar systems or calculated from 
molecular dynamics simulations, 
e.g. using CHARMM. 
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Epsilon / 
kJ mol-1 

Sigma / 
Å 

Mass 
/ amu 

Charge / 
e- 

Ow 0.65 3.16 16 -0.8476 

Hw 0.0 0.0 2 0.4238 



Create a new project and 
the components 
 
• Create new Project. 
• In the Components tab, create the 

molecular components. Remember to 
save the files as .jmol files within jmol.  

• Jmol only gives a rough minimisation of 
the molecular structure – consider 
alternative sources that will provide 
more accurate bond distances and 
angles, or minimisation calculations such 
as MOPAC or Gaussian. To import a 
molecule from other software, export 
the molecule into a format that Jmol can 
read and then save the file in Jmol as a 
.jmol. EPSR will then convert the file to 
an EPSR .mol file. Remember that an 
EPSR .mol file does not have the same 
format as an MDL Molfile and cannot be 
used interchangeably. 

• Edit the Lennard-Jones potentials for 
each of the atom types. Ensure that 
atom type names are unique to a 
component – the same atom type name 
cannot be used in more than 1 
component so will often have to 
changed for one of the components e.g. 
by adding a ‘w’ for water atoms. 

• If the molecule has rigid groups, use 
dihedrals to define these. If the 
molecule has rotatable groups, ensure 
there are no dihedrals restraining these, 
and include a rotational axis in order for 
fmole to rotate the group. 
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Create the simulation box 
 
• In the Simulation Box tab, add the 

correct ratio of atoms to the # in box 
column. Ensure enough atoms are 
added to the box so as half the box 
length is larger than the longest g(r) 
to be assessed. 

• Input the atomic number density in 
atoms Å-3. 

• Use Mixato to add the atoms to the 
box, and Randomise to distribute 
them randomly throughout the box. 

• Check that the box is neutral in the 
simulation box details. 

• To add some disorder to the 
molecule to represent the thermal 
motion of the atoms, click Run fmole 
(10,000 iterations are 
recommended). If necessary, change 
Vibtemp/Angtemp/Dihtemp (increase 
for more rigid restraints) and Run 
fmole afterwards in order for the 
change to be applied throughout the 
simulation box. If the molecule 
contains a flexible group, use 
Ecoredcore to prevent intramolecular 
close contacts, otherwise leave this 
as 0.0 0.0 
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Data, scattering weights 
and EPSR input file 
 
• In the Data and Weights tab, add 

each dataset obtained for the system, 
set up and then make the weights 
files. For this, the following 
information is required: 

• Are the data are from X-ray or 
neutron scattering 

• Which isotopes were present in the 
samples (for neutron data) 

• How the data were normalised 

• What the data file format is (check 
the EPSR manual [Help->EPSR 
manual] for more information). 

• For exchangeable hydrogens, e.g. 
hydrogens bonded to O or N, use 1 in 
the Exchangeable column to indicate 
the atom will exchange and 0 if the 
atom will not. 

• In the isotope column, use 0 for the 
natural isotope for a given element. 
For deuterium use 2 as the isotope. 

• For a 50:50 H:D sample the first 
isotope is 0 as it is natural hydrogen 
and the abundance is 0.5, the second 
isotope is 2 as it is deuterium and the 
abundance is 0.5. 

• In the EPSR input File tab, setup the 
EPSR input file and then Run EPSR. 

 
6 



Improving the simulation 
 
• Once the energy is negative, stop 

EPSR, reset the simulation (ireset 2) 
and start EPSR again to follow the 
change in energy more easily. 

• Check that the model in reciprocal 
space (F(Q)) and real space (G(r)) 
bears some resemblance to the data. 
If it does not, check that the weights 
files are correct, the composition is 
correct, the density is correct and the 
values used in the component 
Lennard-Jones parameters are as 
expected (e.g. the decimal point is in 
the correct place). 

• If all of the above are correct, use the 
G(r) plot to identify if the molecular 
structure is appropriate. If the low r 
peaks are shifted, try to alter the 
bond distances/angles for the 
associated atoms. Changing a single 
bond distance or angle can result in a 
distorted geometry for some 
molecules, e.g. ring systems. For 
these, try using an alternative 
geometry for the whole molecule. 

• Remember to Run fmole 10000 times 
to apply the changes to the 
simulation box. 7 



Improving the simulation 
 

• Plot the simulation box to check 
that the molecules are behaving 
sensibly (Plot->Plot simulation 
box). To view just one component 
select the atoms of the component 
to be excluded from the plot and 
then click plot box. If a molecule 
has a flexible chain, check that the 
chain is not approaching other 
atoms within the same molecule 
too closely (i.e. short 
intramolecular contacts). Change 
Ecoredcore in the Simulation Box 
tab if necessary. This distance 
restraint is overruled by any bond 
and angle restraints defined for 
the component. 

• Start refining ereq to make the 
final improvements via the 
empirical potential. 
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Accumulating the refined 
simulation box 
 

• Once the simulation has been 
improved as far as possible, 
identify a good value for ereq and 
stop the simulation. In the EPSR 
input file tab, use this value of 
ereq as a fixed value and change 
the input file to start accumulating 
frames of the simulation. 

• With the help of the pair 
correlation functions (and the 
EPSR manual), identify analysis 
routines to be performed on the 
simulation while it is accumulating 
and set these up the Analysis tab 
before running EPSR. 

• To perform additional analyses 
after EPSR has started, stop EPSR, 
setup the analysis routine and 
restart EPSR again. Ensure EPSR is 
run for sufficient iterations that 
the results are a good 
representation of the simulation. 
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Some suggested analysis routines: 
 - calculate the coordination number distribution of water molecules around the O of DMSO 
 - calculate the coordination number distribution of water molecules around water 
- Calculate the spatial density function of water around DMSO  



Viewing outputs and 
analysis routine results 
 

• Most outputs (e.g. pair correlation 
functions) and analysis routines 
can be plotted in the Plot data 
window. 

• For spatial density functions (2D or 
3D) a plot file must also be setup. 
Setup plotting routines in the 
lower section of the Analysis tab. 
Refer to the EPSR manual for more 
details on which settings to change 
to achieve this. 
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MCM-41 

EPSRgui tutorial 5 



Purpose of this tutorial 
 
The goal of this tutorial is to build, refine 
and analyse a model of a porous glass, 
MCM-41. To achieve this, the tutorial will 
cover how to: 

• Create the atomic components and 
define the Lennard-Jones potentials 
for each atom type. 

• Create a simulation box containing 
the components and dummy 
components (Q atoms) to create 
pores. 

• Create scattering weights files for 
each of the experimental datasets. 

• Create a simulation that includes 
Bragg peak calculation and run it. 

• Refine the empirical potential. 

• Create analysis routines to probe the 
simulation – how does the structure 
of MCM-41 silica compare to bulk 
silica? 

• Run analysis routines and accumulate 
distribution functions. 

• Plot the results. 
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Lennard-Jones potentials 

For Si and O use the optimised potentials used in Tutorial 1 and adapt these to 
make the hydroxyl group: 

 

 

 

 

 

 

 

 

O1-H1 bond distance:  0.944 Å 

 

Simulation Box 

Composition: SiO2-x(OH)x where x = 10 atom% 

Atomic number density: assume SiO2 is equivalent to bulk silica 0.066 atoms/Å-3 

(hydrogen atoms are ignored) 

Starting pore size: 40 Å diameter 

Starting composition:  Si 503 

  O 906 

  OH 200 

 

Data and Scattering Weights 

Data files – neutron, NIMROD00002401.mint01, no isotopic substitution 

Data normalisation: totals not normalised 

Data type: 5 

Epsilon / 
kJ mol-1 

Sigma / 
Å 

Mass 
/ amu 

Charge / 
e- 

Si 0.8 0.76 28 4 

O 0.65 3.69 16 -2 

O1 0.65 3.69 16 -2 

H1 0.0 0.0 2 1 



MCM-41 
 
MCM-41 is an amorphous silica with cylindrical pores 
arranged in a hexagonal manner. As the pores are 
arranged in an ordered manner, this gives rise to Bragg 
peaks which are visible in the low Q region of data 
collected on NIMROD. A single hexagonal unit cell, with the 
pore positioned in the centre, is highlighted in blue in the 
adjacent image of the pore arrangement. 

From the Bragg peaks, the spacing between the pores and 
therefore the unit cell length can be determined. As the 
100 reflection is at 0.1575 Å-1 (equivalent to a d-spacing of 
39.896 Å), the spacing between the pores is therefore 
46.07 Å (see Soper J. Phys.: Condens. Matter 24 (2012) 
064107 for further details on this). 

To simulate this system, we will therefore create a box 
where 2 sides (a and b) are 46.07 Å and there is a 120° 
angle between these 2 axes (γ). The third box length (c) lies 
along the length of the pore. We will use a relatively short 
(42 Å) distance for this parameter and only 1 unit cell so as 
to speed up the simulation for this tutorial.  

Q atoms will be used to create the pore structure. These 
are dummy atoms and will not contribute to the scattering 
in EPSR. They will be used to maintain the cylindrical 
structure of the pore. 

The size of the pore is not known from the initial 
examination of the data – only by creating a model in EPSR 
and comparing it to the data can the size of the pore be 
determined. The starting size used here is a 40 Å diameter 
pore. This determines the number of Si, O and OH 
components to add to the system in order to maintain an 
atomic number density of 0.066 atoms/Å-3 (equivalent to 
bulk silica). 3 

46.07 Å 

46.07 Å 



Create the components 
- Q atom lattice 
 
• Create new Project called MCM41_40 

where the ‘40’ represents the pore size. 
• First, the lattice of Q atoms (dummy 

atoms) needs to be constructed. 
• In the Components tab, click Create 

atomic lattice. 
• In the Name box type Qlatt as this will 

be the lattice of Q atoms to create the 
cylindrical pores in MCM-41. 

• a, b, c, alpha, beta, gamma are the 
lattice parameters.  

• Click Add row and complete the Atom 
label and the atom coordinates x, y and z 
so as to make an effectively cylindrical 
pore in the centre of the cell. The 
spacing of the Q atoms is to make a 
smooth sided cylinder rather than just a 
few spheres next to each other. 

• Fill out the Lennard Jones parameters for 
the Q atom. Epsilon and sigma values 
are used so as to create an appropriate 
sized pore by keeping the Si and O atoms 
away from the Q atoms. A larger epsilon 
than the pore radius is required due to 
the Lorentz-Berthelot mixing of the 
individual atom potentials. 

• Use only 1 cell along each axis to form 
the lattice. 

• Click OK. 
• The lattice will appear in the 

Components list. 
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Create the components 
- Si, O and OH 
 
• MCM-41 is predominantly SiO2, 

however, studies have shown that 
approximately 10% of the O atoms 
are actually OH. 

• There is evidence that these hydroxyl 
groups are distributed throughout 
the silica and are not just on the 
surface of the pore. 

• Create the Si and O atoms using the 
Create single atom button. Use the 
potentials listed at the start of this 
tutorial. 

• For the hydroxyl group, click Create 
new and make the component in 
Jmol. MOPAC is not necessary as the 
O1-H1 bond distance and Lennard-
Jones parameters will be defined 
next anyway. 

• Click on the OH component in the list 
and change the Lennard-Jones 
parameters to those listed at the 
start of this tutorial. 

• Click Update. 

• Click on the Bond distance tab and 
change the O1-H1 bond distance too. 

• Click Update. 
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Create the simulation box 
 

• In the Simulation box tab, click 
Addato. 

• In the window that opens, select 
the Q lattice as the container. 

• Then add the Si and O atoms to 
the table of components to be 
added to the container using the 
>> button. 

• Enter the number of Si, O and OH 
components to be included in the 
box and click Ok. 

• Check the box has been 
constructed correctly by plotting 
the simulation box. 
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Data, scattering weights 
and EPSR input file 
 

• In the Data and Weights tab add 
the dataset and make the weights 
file. 

• Click on the EPSR input file tab and 
click Setup EPSR input file. 

• In the Edit input file tab on the 
EPSR input file tab, change: 

• nq 2000  

• qstep 0.01 

• fwhmq 0.03 

• revlorch 1.0 0.0 

• qwidthqmax -0.003 0.6 

• hklqmin 0.01 5.5 0.0 

• qmin 0.1 0.1 
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• nq This is the number of Q values used in the simultaion, the default of 600 is not 
sufficient to cover the Q range required (0.05 to 50 Å-1) when we use smaller binning in 
order to resolve the Bragg peaks. The maximum number of Q values allowed is 2000 so 
we will use this. 
 

• qstep This is the size of the spacing between the simulated Q values. While 0.05 Å-1 is 
appropriate for the short-range structure, it is too broad to see the peak shape of the 
Bragg reflections and whether they are being appropriately modelled. A value of 0.01 Å-1 

is a compromise between being able to resolve the Bragg peaks and being able to reach 
an appropriate Qmax (otherwise the data will be significantly broadened in real space). 
 

• fwhmq This is determined by the resolution of the instrument – NIMROD has slightly 
lower resolution than SANDALS which is not usually noticed for liquid and glass samples 
without Bragg peaks, but is relevant here. 
 

• revlorch This applies a revised Lorch function that is used to remove truncation 
oscillations at low Q arising from the real space data not quite reaching 1 at high r. The 
first value can be used to specify a constant broadening or the second value can be used 
to apply a Q dependent broadening. 
 

• qwidthqmax The modulus of the first value sets the width of the calculated Bragg peaks; 
the shape of the peak is gaussian if qwidth is > 0 and Lorentzian if qwidth is < 0. The 
second value sets the maximum Q up to which the Bragg peaks will be calculated and 
therefore must be > 0 for any Bragg peaks to be calculated. Calculation of Bragg peaks 
can be very slow if there are a large number of Bragg peaks in the specified Q range, 
therefore only use a value up to which there are Bragg peaks. 
 

• hklqmin The first value specifies the minimum Q for which Bragg peaks will be 
calculated.  In this instance the Bragg peaks are present until the minimum Q value of 
the data (0.05 Å-1), therefore that is used here. The second value specifies the radius in 
the G(r) from which the Fourier transform of the data to real space is based on the Bragg 
peaks. This is the point where the sharp peaks from the short range order become 
indistinct prior to the higher r region which will be contributed to by the long range 
order (Bragg peaks). The third value is the Debye-Waller factor and should be left as 0 as 
the thermal motion of the atoms will be included in the disorder intrinsic to the 
simulation. 
 

• qmin The first value gives the smallest value of Q to be used when performing a Fourier 
transform. As there is Porod scattering in the data which cannot be fitted, it is sensible 
to use a Q value just before the start of the first Bragg peak. The second value gives the 
minimum Q value to be used to fit the potential and is generally the same as the first 
value. 
 



EPSR input file (continued) 
 
• In the Edit .pcof file tab on the EPSR 

input file tab, change: 
• rminpt 12 

• rmaxpt 24 

• As the simulation has only just been 
setup, ireset and iinit are 1 in order 
to initialise the calculation of the 
potential. During this initialisation 
values such as minimum distances 
are reset therefore Run EPSR once. 

• Once EPSR has finished, change the 
minimum distances (Å) in the Edit 
minimum distances tab on the EPSR 
input file tab: 

• Q Si 19.8 

• Q O 18.0 

• Q O1 18.0 

• Q H1 17.0 

• Now Run EPSR. 

• Check that the energy is decreasing 
and that the pore remains empty of 
atoms.  

• Once the energy is negative, Stop 
EPSR, change ireset to 2 and Run 
EPSR again.  
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rminpt This sets the radius at which truncation of the potential begins. It is generally half of 
rmaxpt. 
 
rmaxpt This sets the radius at which the potential is truncated to 0.0. It should be larger 
than the radius of the largest object in the box. 

Consider why the minimum distances given here have been suggested. 



Plotting the data 
 
• Continue running EPSR, keeping an eye 

on the Energy, R-factor, G(r) and F(Q) 
plots to check that the silica structure is 
forming.  

• For the F(Q) plot, the large small angle 
scattering makes the data difficult to see 
on a linear scale.  

• For the Quick Plots, use the log x and log 
y tick boxes to view F(Q) on a log scale. 
The data are automatically offset by 1 
along y when using a log y scale. 

• To view the data more clearly use the 
Plot->Plot data. Click on the Options 
button and select log x, log y and change 
the zero offset along y to 1.0. To remove 
the difference curve which can make it 
difficult to see the model and data at the 
early stages of the simulation, untick the 
Show residual box. 

• Note that R-factor is calculated as chi-
squared – the first Bragg peak has a 
significantly larger amplitude than the 
rest of the data, and, once squared, it 
dominates the R-factor. Therefore, while 
it is still of use to monitor the change in 
R-factor, visual inspection of the fit will 
be much more informative to ensure 
both the long range and short range 
aspects of the data are fitted well. 
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Improving the simulation 
– Bragg peaks 
 
• While there may be some 

discrepancies in the intensities of 
the Bragg peaks (discussed later), 
the shape of the Bragg peaks can 
be improved first. Try changing: 

• qwidth – try using different sizes 
(e.g. in 0.001 steps) and also try 
using gaussian and lorentzian 
peak shapes. In order to do this, 
Stop EPSR, change the first value 
in qwidthqmax and also change 
ireset to 2. Allow the simulation 
to run for a few iterations in 
order for  the changes to 
manifest completely in the Bragg 
peaks.   

• qmax – on inspection of the data 
you will notice there is a ‘step’ 
where the Bragg peak calculation 
stops. It is better to have this on 
the edge of a Bragg peak in order 
to minimise its effect on the 
data. In order to do this, Stop 
EPSR, change the second value in 
qwidthqmax to a more 
appropriate Q value and also 
change ireset to 2. Allow the 
simulation to run for a few 
iterations. 
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Improving the simulation 
– pore size 
 
• The pore size used to start was estimated from 

previous studies. Although the pore size cannot 
be measured directly from the data, the Bragg 
peak intensities enable it to be determined. 

• Create a new project with a 38 Å and again with a 
36 Å pore diameter (make a new project for 
each, e.g. MCM41_38) to determine the most 
appropriate pore size. 

• To do this, you will need to calculate the number 
of Si, O and OH components to include in the 
simulation box in order to maintain 0.066 
atoms/Å3 for the SiO2 density (ignore the H) for a 
given pore size. 

• Use the same ratio of atoms as for the 40 Å pore 
but increase the total number of atoms to 
account for the decrease in pore size. 

• Follow the steps in the previous pages but use 
Load existing in the Components tab to use the 
components you have already made. 

• Change the sigma for the Q atoms to be slightly 
smaller so as to produce a smaller pore radius on 
using Addato. 

• For each of the pores, after running EPSR once, 
change the minimum distances in the EPSR input 
file tab to be equivalent to the radius of the pore. 

• The differences between the model and data 
owing to the pore size will be predominantly in 
the low Q region as it is the meso-scale 
correlation lengths that are being changed. Any 
discrepancies in the short range, Si-O etc, 
distances will be addressed later with the 
empirical potential. 
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Improving the simulation 
– the empirical potential 
 
• Choose the pore size with the best fit to 

the data to continue the tutorial with. 

• If necessary, stop EPSR. 

• In the EPSR input file tab, change the 
ereqstep value to be 1.0 and sfreq to be 
50 5. Also, change the ireset value to be 
2. 

• Run EPSR again. 

• Check how increasing ereq is affecting 
the structure of the silica by examining 
the G(r) plot. The fit to the peaks 
between 3 and 6 Å should be improving. 
Also check how EPSR is changing ereq by 
selecting ereq from the plot drop down 
menu and clicking Plot. 

• You may find that the empirical potential 
is not necessary, or that the iterative 
method does not find a minima. If this is 
the case try using a fixed value for ereq 
with ereqstep 0.0 and manually change 
the value of ereq – check how ereq 
affects the fit to the data by examining 
the F(Q), G(r), energy and R-factor plots. 

• Once the simulation has been improved 
as far as possible, Stop EPSR, stop 
refining ereq and set it to the optimum 
value. Start accumulating frames of the 
simulation (nsumt). Before starting EPSR, 
set up any analysis routines… 
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Analysing the refined 
simulation box 
 
• On the top menu bar, click Plot->Plot 

data. 

• In the plotting window that opens, click 
g(r) inter to plot the intermolecular pair 
correlation functions for selected atom 
pairs. 

• Click on each atom in a pair and click the 
>> button to add the pair to the list of 
pair correlation functions to be plotted. 
Repeat this for each atom pair to be 
plotted. To remove an atom pair, click on 
it and then click the << button. 

• Then click Plot. 

• This plots the intermolecular g(r) 
together with the coordination number 
(in grey). 

• Compare these plots with those 
obtained from bulk silica. 

• In the Analysis tab setup analysis 
routines Coord and Triangles in order to 
compare the structure of bulk SiO2 with 
MCM-41. 
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Performing calculations 
 

• Once all the calculations have 
been set up, run EPSR. 

• Even while EPSR is running, the 
outputs from the calculations can 
be viewed by clicking Plot->Plot 
data. 

• In the top right hand corner, the 
calculations that are running while 
EPSR is running are listed. 

• Click on the CN.COORD calculation 
and click Options on the bottom 
right hand corner. This opens 
additional plotting options. 

• Select the atom pair you want to 
see the coordination number for in 
the list in the Plot type specific 
options box and then click Plot. 

• Compare the results between O 
and O1 and with that for bulk 
silica. Repeat for Triangles. 
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Additional work 
Improving the simulation – 
silanol group location 
 
• While there is some evidence that the 

silanol groups are distributed randomly 
throughout the silica, there is also some 
evidence that they are only present on the 
surface of the pore. 

• To examine which best fits the data, Stop 
EPSR. 

• Make a copy of the simulation File->Save 
As e.g. MCM-41surf. 

• Wait for the files to be copied – a message 
shows in the bottom right hand corner 
once this has been completed. 

• In the menu bar, click Edit->Delete EPSR 
input file. 

• In the Simulation Box tab, click Remove 
component. Select the OH.ato file and click 
Remove to remove the hydroxyl groups 
from the simulation box. 

• Go to the Components tab and click Load 
existing to load the OH component back in 
to the project. 

• Click on the Qlatt component, change the 
epsilon to be small enough to form a layer 
of OH around the pore and click Update. 

• In the Simulation Box tab change the fmole 
iterations to 1 and click Run fmole. This 
applies the changes made in the 
Components tab to the simulation box. 
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Additional work 
Improving the simulation – 
silanol group location 
 
• When Addato adds components to a container, it uses 

the epsilon and sigma values of any tethered 
components to work out where to put the additional 
components. 

• Therefore, in the Simulation Box tab, click on the 
Tethering button and change each of the atoms listed 
to T with a tether atom ‘0’ (zero). Click Update box. 

• Click Addato and select MCM-41surfbox.ato as the 
container from the dropdown list and select OH.ato 
as the component. Add the number of OH to include 
and click Ok. 

• In the composition box that appears, check that the 
correct number of OH components have been added 
to the box. If some are missing this is because there 
was not enough space for them in the box given the 
sigma values of OH and the tethered components. 

• Now untether the Si and O atoms by changing the 
tethered column to F and clicking Update box. 

• As the scattering weights files already contain the O1 
and H1, they are fine to continue using. 

• In the EPSR input file tab, click Setup EPSR input file. 
Change the input and .pcof file parameters for the 
Bragg peak calculation and Run EPSR once. Change 
the minimum distances and Run EPSR again. 

• Examine which has the best fit to the data – the 
simulation box with the silanols distributed randomly, 
or the simulation box with the silanols at the surface 
of the pore. 
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MCM-41 loaded with N2 

EPSRgui tutorial 6 



Purpose of this tutorial 
 
The goal of this tutorial is to refine a 
model of a vapour deposited in MCM-
41. This tutorial assumes tutorial 5 
(MCM-41) has already been completed 
and uses the refined model of the 
MCM-41 system as the starting point 
for this tutorial. This tutorial will cover 
how to: 

• Remove Q atoms. 

• Add components to a pre-existing 
simulation box. 

• Create scattering weights files for 
each of the experimental datasets. 

• Create a simulation and run it. 

• Refine the empirical potential. 

• Create analysis routines to probe 
the simulation. 

• Run analysis routines and 
accumulate distribution functions. 

• Plot the results. 
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Lennard-Jones potentials 

 

 

 

 

 

N1-N1 bond distance:  1.11 Å 

 

Simulation Box 

Composition: SiO1.9(OH)0.1 . 0.31N2 

 

Data and Scattering Weights 

Data files – neutron, NIMROD00002404.mint01 , no isotopic substitution  

Data normalisation: totals not normalised 

Data type: 5 

Epsilon / 
kJ mol-1 

Sigma / 
Å 

Mass 
/ amu 

Charge / 
e- 

N1 0.31013 3.31 14 0 



Save an existing project 
with a new name 
 

• First, open the existing project: on 
the top menu bar, click File -> 
Open… 

• Open the project from Tutorial 5 
that had the best fit to the data.  

• On the top menu bar, click File -> 
Save As… 

• Type the name for the new 
project, e.g. MCM41_N2 and click 
OK. 

• The EPSR input file for the bare 
MCM-41 will not be applicable to 
the loaded MCM-41, therefore 
click Edit->Delete EPSR input file. 

• In the Data and Weights tab, 
Remove the data file as new data 
and weights files are required. 
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Preparing the simulation 
 
• In the Simulation box tab, tether (T) each 

of the components using 0 as the tether 
atom. 

• In the Components tab, click Create new 
and create N2 in Jmol. 

• Once created, edit the Lennard-Jones 
parameters and the bond distance to be 
those stated at the start of this tutorial 
and click Update. 

• Edit the sigma and epsilon values of the 
Q atoms in Qlatt to 0.0 and 0.0 so as 
there is space for the N2 molecules in 
the pore 

• In the Simulation box tab, Run fmole 
once to apply the new sigma and epsilon 
values to the box. 

• Calculate the number of nitrogen 
molecules added to the pore given the 
molar ratio at the start of this tutorial 
and the number of Si atoms used to 
create the box in the last tutorial. 

• Click Addato and choose the simulation 
box as the container and add the 
appropriate number of nitrogen 
molecules and click Ok. 

• Check the simulation box looks Ok. 
• Untether Si, O and OH by typing ‘f’ in the 

Tethered? column and deleting the entry 
in the tether atom column. Click Update 
box. 
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Data, scattering weights 
and EPSR input file 
 
• In the Data and Weights tab add the 

dataset and make the weights file. 

• Click on the EPSR input file tab and 
click Setup EPSR input file. 

• Change the parameters in the Edit 
input file tab and Edit .pcof file tab to 
be consistent with those used to 
generate the best fit in the in the 
empty MCM-41 tutorial. 

• Run EPSR once. 

• Once EPSR has finished, change the 
minimum distances (Å) in the Edit 
minimum distances tab on the EPSR 
input file tab: 

• Q Si 19.8 

• Q O 18.0 

• Q O1 18.0 

• Q H1 17.0 

• Now Run EPSR. 

• Check that the energy is decreasing 
and that the pore only contains 
nitrogen molecules.  

• Once the energy is negative, Stop 
EPSR, change ireset to 2 and Run 
EPSR again.  
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Improving the simulation  
 

• Inspect the data in real space. 
There is a large mismatch between 
the model and the experimental 
data in the mid r region. 

• As the nitrogen molecules have 
been added to the whole pore but 
are likely on the surface, use a 
minimum distance to move the 
nitrogen molecules away from the 
centre of the pore. 

• Try different values to see which 
provides the best fit. 

• Examine the data in reciprocal 
space – adjust the Bragg peak 
calculation parameters to account 
for the change in Bragg peaks. 

• Once optimised and the box has 
equilibrated increase the value of 
ereq (iteratively or manually) using 
the previous value of ereq for bare 
MCM-41 as a guide.  
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Accumulating and analysing 
the refined simulation box 
 

• Once the simulation has been 
improved as far as possible, 
consider which analysis routines 
could be used to examine the 
simulation box. 

• Set these up and also start 
accumulating the simulation. 

• Plot the results. 
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Ice 

EPSRgui tutorial 7 



Purpose of this tutorial 
 
The goal of this tutorial is to build, refine 
and analyse a model of a disordered 
solid, ice at 220K. To achieve this, the 
tutorial will provide suggestions on how 
to: 
• Create the atomic components and 

define the Lennard-Jones potentials 
for each atom type. 

• Create a simulation box containing 
the components already on their 
lattice positions. 

• Create scattering weights files for 
each of the experimental datasets. 

• Create a simulation that includes 
Bragg peak calculation and run it. 

• Improve the simulation and refine 
the empirical potential. 

• Create analysis routines to probe the 
simulation – how does the structure 
of ice compare to that of water (e.g. 
from the DMSO-water tutorial or 
pure water from the literature.) 

• Run analysis routines and accumulate 
distribution functions. 

• Plot the results. 
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Lennard-Jones potentials 

SPC-E water: 

 

 

 

 

 

O1-H1 bond distance:  0.976 Å 

H1-O1-H1 bond angle: 104.5° 

 

Simulation Box 

Composition: H2O 

Atomic number density: determined by crystal structure 

 

Data and Scattering Weights 

Data files – neutron, SLS03449.mint01, natural hydrogen 

 neutron, SLS03460.mint01, null water 

 neutron, SLS03468.mint01, fully deuterated 

Data normalisation: totals not normalised 

Data type: 5 

 

Neutron scattering lengths 

https://ncnr.nist.gov/resources/n-lengths/ 

Epsilon / 
kJ mol-1 

Sigma / 
Å 

Mass 
/ amu 

Charge / 
e- 

O1 0.65 3.16 16 -0.8476 

H1 0.0 0.0 2 0.4238 



Ice at 220K 
 
The data for this tutorial are from: 

Proceedings of the International School of Physics “Enrico 
Fermi”. Course 187 “Water: Fundamentals as the Basis for 
Understanding the Environment and Promoting Technology”, 
edited by P. G. Debenedetti, M. A. Ricci and F. Bruni (IOS, 
Amsterdam; SIF, Bologna) 2015 

DOI 10.3254/9781-61499-507-4-151 

 

Ice has a complex phase diagram with various hydrogen 
bonded arrangements of the water molecules as well as proton 
ordered and proton disordered forms of each arrangement 
(except for one of the phases… 
http://ergodic.ugr.es/termo/lecciones/water1.html). 

 

These data were obtained by crash cooling liquid water to 
220K, resulting in a disordered form of ice 1h. Data were 
collected five times for each sample – the sample was heated 
to 298K in between each data collection before being crash 
cooled again. This was to remove any effects of preferred 
orientation of the ice crystals from the data. 

 

Ice 1h is a proton disordered form and therefore has four half 
occupancy hydrogen atoms per water molecule. The structure 
of ice 1h can be obtained from the ICSD (icsd.cds.rsc.org/ ) or 
the CCDC (https://www.ccdc.cam.ac.uk/)  in the form of a cif 
file (crystallographic information file). The cif file contains the 
atom positions for the asymmetric unit which are then 
multiplied by the symmetry operators to produce the unit cell. 
The unit cell is repeated by translation to produce the crystal 
lattice. 
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Preparing the components 
 
• To use the cif file, first the structure must be 

converted into the space group P1 which 
does not contain any symmetry. This can be 
done by multiplying out the atom positions 
with the symmetry elements, or, in software 
such as CrystalMaker, using ‘Transform cell’ 
to convert to P1. This has already been done 
in the file ice_1h_P1.cif 

• EPSR does not account for half occupancy 
hydrogen atoms, therefore to use the cif file 
as a starting point, the additional hydrogen 
atoms must be removed. This can be done 
manually, or by deleting them via software 
such as CrystalMaker. This has already been 
done in the file ice_1h_P1.cif 

• What might be problematic when deleting 
the hydrogen atoms? 

• In order to use the unit cell in EPSR, it must 
be in the format of an EPSR .ato file. 
Therefore Aten has been used to convert 
the unit cell to a .ato file. For this, the unit 
cell in P1 with no half occupancy atoms, and 
the Lennard Jones potentials for each of the 
atoms are required. After creating the .ato 
file, open it with a text editor and scroll to 
the bottom of the file. Where it says 
moltypeXX, delete the moltypeXX and 
replace it with water. This is the name of the 
component that will be used in EPSR. The 
resulting file is in the Resources folder. 
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Optional 
Preparing the components 
- using Aten to create a .ato file 
 
• Open Aten and open the file ice_1h_P1.cif. 
• On the left hand side of the screen click the 

vertical bar that has 3 atoms in it. This shows the 
atoms present in the structure. Reorder the 
atoms (by clicking on an atom  in the list and 
using the arrow buttons) so that the atoms for 
each molecule are consecutive and the oxygen 
atom is first.  

• Click on the Forcefields tab and click Open. Click 
on the aten folder in the Favourites list and go to 
the ff folder, select the spce.ff file and click 
Open. The forcefield SPC-E water will now be 
shown in the list. To the right of this list, click 
Assign. 

• Click on the Home tab and Save the structure as 
a .ato file, e.g. ice_1h_P1.ato, in the project 
folder. 

• Check that the following message in red does 
not appear: 

Pattern creation failed because of bad atom ordering of the 
presence of additional bonds. 
Problem occurred in pattern 1 whilst selecting from atom X. 

• If it does, amend the atom ordering and try 
saving the file again.  

• Otherwise, open the file in a text editor. At the 
bottom of the file there will be a line that says 
moltypeXX or OH2. Change this word to be the 
name of the component. 

• Check that the atom types used in the .ato file 
are the same as the labels used in the 
component (change the component if 
necessary). 

• The .ato file is now ready for loading into 
EPSRgui using Load box. 
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Create the components 
and simulation box 
 
• Create new project called ice_tut. 

• Click Create new and make a water molecule 
named water.jmol. 

• Change the Lennard Jones potentials, 
charge, bond distance and bond angle to be 
appropriate to SPC-E water (given at the 
start of this tutorial). Change the atom types 
to be the same as are listed in ice_1h_P1.ato 
(i.e. OW and HW). Click Update. 

• In the Simulation Box tab click Load box. 
Click Ok to the message box that 
‘moltypeXX’ has been changed to the name 
of the component. Open the ice_1h_P1.ato 
file. 

• In the Simulation box details the unit cell 
parameters will be shown. The structure can 
be checked further by plotting the 
simulation box. 

• To create a large box out of this small unit 
cell, click Create molecular lattice. Select 
ice_1h_P1.ato from the dropdown list and 
expand the unit cell 5 times in each 
direction. 

• The simulation box is now called ice2box 
and the details are shown in the Simulation 
Box tab. 
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Create the simulation box 
(continued) 
 
• Click Tethering and tether the water 

molecules via the oxygen atoms. Use a ‘T’ 
in the Tethered? column and type the 
atom label for the oxygen atom, ‘1’, (as 
the lattice of oxygen atoms is not 
disordered)  in the Tether atom column.  
Change the Tethering tolerance to 0.1.  

• Click Step sizes and change: 
• Intramolecular translation ss: 0.3 

• Group rotation ss: 0.0 

• Whole molecule rotation ss: 0.3 

• Whole molecule translation ss: 0.0 

This changes the size of each step EPSR 
will move the molecules – the smaller 
moves will prevent the structure from 
becoming too disordered too quickly, and 
the 0.0 step sizes will prevent these 
moves from occurring. 

• Click Update box. 

• To make sure the water molecules have 
the correct Lennard-Jones parameters 
and bond distance and angles, Run fmole 
10000 times. 

• Check the simulation box looks Ok. 
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Data, scattering weights 
and EPSR input file 
 

• In the Data and Weights tab add 
the dataset, fil out the 
exchangeable and isotopically 
substituted atoms and make the 
weights file. 

• Click on the EPSR input file tab and 
click Setup EPSR input file. 

• In the Edit input file tab on the 
EPSR input file tab, change: 

• nq 2000  

• qstep 0.01 

• rotfreq 1 (this is the number of 
iterations between rotation 
moves; as rotation is what the 
water molecules need to do to fit 
the data, it is useful to perform 
rotations every iteration) 

• qwidthqmax -0.003 8.0 

• hklqmin 0.3 3.0 0.0 

• qmin 1.0 1.0 

• Now Run EPSR. 
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Improving the simulation 
 

• Check the fit to the data in reciprocal 
and real space and how the energy 
and R-factor are changing. 
Periodically check how the 
simulation box is changing. 

• Areas to consider for improvement: 

• How crystalline is the O atom 
lattice? Try changing the Tethering 
tolerance and see how this affects 
the model. 

• Are the Bragg peak calculation 
parameters appropriate? Try 
changing qwidthqmax, hklqmin and 
mplicities. mplicities can be used to 
split the simulation box into smaller 
unit cells for the Bragg peak 
calculation. For instance, 2 2 2 
would mean that a unit cell of ½ a, 
½b and ½c would be used for the 
Bragg peak calculation. Reducing 
the cell size reduces the number of 
Bragg peaks calculated, but also 
loses information about the diffuse 
scattering. 
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Analysing the refined 
simulation box 
 
• Using the EPSR manual, consider which 

analysis routines will probe the ice 
structure and set these up to run while 
EPSR is accumulating. 

• Compare the radial distribution 
functions with literature data. 

• Plot the results. 
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